Keysight Wireless Test Set

E6640A Wireless Test Set

Getting Started Guide
Notices

© Keysight Technologies, Inc. 2014–2019

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Keysight Technologies, Inc. as governed by United States and international copyright laws.

Trademark Acknowledgments

Manual Part Number
E6640-90001

Edition
Edition 1, January 2019
Supersedes: March 2016
Printed in USA/Malaysia

Published by:
Keysight Technologies
1400 Fountaingrove Parkway
Santa Rosa, CA 95403

Warranty

THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS,” AND IS SUBJECT TO BEING CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED WITH REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR ANY INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH WARRANTY TERMS

COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT WILL CONTROL.

Technology Licenses

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer software,” as defined by Federal Acquisition Regulation (“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”) 227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at http://www.keysight.com/find/sweula

The license set forth in the EULA represents the exclusive authority by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the public to use, modify, reproduce, release, perform, display, or disclose commercial computer software or commercial computer software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.

Safety Notices

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these products, including instrument software upgrades, application information, and product information, browse to one of the following URLs, according to the name of your product:

http://www.keysight.com/find/exm

To receive the latest updates by email, subscribe to Keysight Email Updates at the following URL:

http://www.keysight.com/find/MyKeysight

Information on preventing instrument damage can be found at:

www.keysight.com/find/PreventingInstrumentRepair

Is your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements. To search for software updates for your product, go to the Keysight Technical Support website at:

http://www.keysight.com/find/techsupport
Table of Contents

Quick-Start 7
About the Test Set 8
   Elements of the TRX 9
      Input/Output Matrix (M9432A, Option 2FD) 10
      Input/Output Matrix (M9433A, Option 4FD) 11
Initial Inspection 12
   Shipping problems? 13
Test Set Location and Mounting Requirements 14
   Locating the test set 14
   Cooling and rack mounting 14
Separate Application Interfaces 15
Turning on the test set the first time 17
   Initializing the test set using a USB mouse and external monitor 17
Options and Licenses 21
   Option 2FD 22
   Option 4FD 22
   Option 5B0 22
Anti-Virus Software and Firewalls 23
Shortening the Test Set Power-On Time 23
Instrument Safety & Environmental Information 24
   Power requirements 24
   Environmental Conditions (Operating) 25
   Ventilation 26
   Instrument Maintenance 26
   Protecting against electrostatic discharge 28

Front and Rear Panel Features 29
Front Panel Features 30
   Controller Hardware Interface 31
   TRX Module Hardware Interface 33
   Reference Module Hardware Interface 35
   Virtual Front Panel 36
   When the Test Set is Controlled Remotely 38
   Display Annotations (XSA interface) 39
   Display Annotations (XSA MultiTouch interface) 41
Rear Panel Features 43
Front and Rear Panel Symbols 44

XSA Interface 47
  Distinguishing the Interfaces 48
  Alignments 49
    “All” Alignment (daily use) 49
    Weekly alignment procedure 50
  TRX Selection 51
    Using HiSLIP 51
    Using Socket Ports 52
    Using VXI-11/SICL 52
    Using Telnet Connection 52
  E6640A Calibration Status 53
    Certificates of Calibration 54

Desktop Icons 55
  TRX Configurator 56
  Launch XSA 57
  Configure XSA Applications 58
  Minimized Windows 59

Port Configuration 60
  Full Duplex Port Setup (RFIO 1 and RFIO 2) 61
  Separate Input and Output Port Setup (RF3 I/O and RF4 I/O) 63
  Separate Input and Output Port Setup (RFIO 1 and RFIO 2) 67
  Option 4FD: Full Duplex Port Setup 69
  Option 4FD: Separate Input and Output Port Setup 70

LAN Address Configuration 71

Switched MIMO 72
  Constraints on Radio Standards 72
  MIMO Port Configuration 72
  Source Sync Control 73
  RF Input Port Mode 73
  Half Duplex RF Input 73
  Acquisition Triggers 74
  Acquisition Integration 74
  Acquisition RF Input Port 75
  Switched MIMO Modulation Accuracy measurement SCPI commands 76
  Switched MIMO Results 78

True MIMO 79
  TRX Configurations 79
  Source Settings for MIMO 82
  Constraints on Waveform File Names 84
Constraints on TRX Selection 84
Constraints on Radio Standards 85
MIMO Type 85
Remote Analyzer Configuration 85
MIMO Modulation Analysis measurement SCPI commands 87
MIMO Modulation Analysis Results 88

Tx Beam Forming 91
 Tx Beam Forming Commands 91
 Tx Beam Forming Results 92

XSA MultiTouch Interface 93
 Distinguishing the Interfaces 94
 Alignments 95
 "All" Alignment (daily use) 95
 Weekly alignment procedure 96

TRX Selection 97
 Using HiSLIP 97
 Using Socket Ports 98
 Using VXI-11/SICL 98
 Using Telnet Connection 98

E6640A Calibration Status 99
 Certificates of Calibration 100

Desktop Icons 101
 TRX Configurator 102
 Launch XSA MultiTouch 103
 Configure Applications MultiTouch 104
 Minimized Windows 105

Port Configuration 106
 Full Duplex Port Setup 107
 Separate Input and Output Port Setup 108

LAN Address Configuration 109

Test Set Operating System 111
 Keysight Software Installed 112
 Measurement Software Applications 112
 Customer Installation of Software 113
 3rd party software verified by Keysight 113
 Installation of other 3rd party software 113

User Accounts 114
 Administrator login 114
 User login 114
Contents

Customer creation of accounts 115
Keysight Licensing Options 116
   Time-Limited Licenses (Trial Licenses) 116
Licensing New Measurement Application Software – After Initial Purchase 118
   Installation procedure over USB 118
Transporting a License Between Test Sets 120
   Procedure for Transporting a License, Neither Test Set Connected to the Internet 120
Windows Configuration 123
   Settings that can be changed 123
   Settings that must not be changed 124
Configuring Printers 126
Configuring LAN 126
   Hostname 126
   IP Address & Gateway 126
Windows Security 127
   Windows Firewall 128
   Automatic updates 129
   Virus protection 130
   Spyware protection 130
System Maintenance 131
   Backup 131
   System restore 131
   Disk defragmenting 131
USB Connections 132
Hard Drive Partitioning and Use 134
Hard Drive Recovery Process 135
   Updating the software 137
   Configuring recovery prompt timing 144
Windows Operating System 145
   Navigating Windows Without a Mouse 146
Remote Desktop: Using the Test Set Remotely 147
   Overview of Remote Desktop operation 147
   Setting up Remote Desktop operation 148
   How to locate the computer name of the test set 149
   Running a Remote Desktop session 151
   The Virtual Front Panel 161
Programmatic Control of the Test Set 162
Capturing/Printing Displays and Windows 163
Windows Shortcuts and Miscellaneous Tasks 164
Contents

Windows shortcuts (key combinations) 164
Windows taskbar auto-hide feature 166
Windows startup folder 168

Troubleshooting 169

Check the Basics 170
Problems with Microsoft Windows Operating System 172
Returning a test set for Service 173
   Read the Warranty  173
   Service Options  173
   Calling Keysight Technologies  173
   Locations for Keysight Technologies 173
   Packaging the Test Set 174
1 Quick-Start

This section explains how to initialize the test set and generate and view a signal.

“About the Test Set” on page 8
“Initial Inspection” on page 12
“Test Set Location and Mounting Requirements” on page 14
“Turning on the test set the first time” on page 17
“Options and Licenses” on page 21
“Anti-Virus Software and Firewalls” on page 23
“Shortening the Test Set Power-On Time” on page 23
“Instrument Safety & Environmental Information” on page 24
About the Test Set

The E6640A EXM Wireless Test set contains one to four Keysight M943xA TRXs. The specific TRX model number is dependent on the options and applications ordered with the test set:

- M9432A (Option 2FD) has 2 half-duplex and 2 full-duplex ports.
- M9433A (Option 4FD) has 4 full-duplex ports.

**NOTE** Two older TRX models are no longer being manufactured, but it is usually possible to repair and recalibrate them if necessary: M9430A (2 half-duplex and 2 full-duplex ports), and M9431A (4 full-duplex ports).

**NOTE** The M9432A TRX is not currently supported by the 5G NR test application.
Elements of the TRX

Each TRX contains the full set of hardware elements illustrated below. Two separate examples are shown, for models M9432A (Option 2FD) and M9433A (Option 4FD).

Each TRX is run by its own instance of the XSA firmware application. A fully loaded test set shows four independent XSA windows on its monitor display.

The TRX includes a signal analyzer and a signal source, both of which interface with the front panel of the test set through an input/output matrix, and each of which is controlled by an independent list sequencer (the two sequencers exchange trigger signals to coordinate their operations).
Input/Output Matrix (M9432A, Option 2FD)

The input/output matrix is illustrated below, for the M9432A TRX. Ports RFIO 1 and RFIO2 are full-duplex ports (simultaneously inputs and outputs). Ports RF3 I/O and RF4 I/O can be inputs or outputs, but not simultaneously.

Figure 1-2  M9432A input/output matrix

See “Port Configuration” on page 106 for more information about port setup in connection with the 5G NR application. See “Port Configuration” on page 60 for more information about port setup in connection with other applications.
Input/Output Matrix (M9433A, Option 4FD)

The input/output matrix is illustrated below, for the M9433A TRX. Ports RFIO 1 through RFIO4 are full-duplex ports (simultaneously inputs and outputs).

Figure 1-3 M9433A input/output matrix

See “Port Configuration” on page 106 for more information about port setup in connection with the 5G NR application. See “Port Configuration” on page 60 for more information about port setup in connection with other applications.
Initial Inspection

Inspect the shipping container and the cushioning material for signs of stress. Retain the shipping materials for future use, as you may wish to ship the test set to another location or to Keysight Technologies for service.

<table>
<thead>
<tr>
<th>Item</th>
<th>Deliverable</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keysight Model E6640A</td>
<td>EXM Wireless Test Set</td>
<td></td>
</tr>
<tr>
<td>Getting Started Guide</td>
<td>The present document. Provides first-time power on instructions, licensing information, operating system information, and general hardware information.</td>
<td></td>
</tr>
<tr>
<td>USB keyboard &amp; mouse</td>
<td>A keyboard and mouse for communication with the controller and measurement applications. (These accessories are provided only if options E6640A-KYB and E6640A-MSE are ordered.)</td>
<td></td>
</tr>
<tr>
<td>Monitor cable adapter (Display Port to VGA)</td>
<td>An adapter for the front panel Display Port which makes it possible to use the test set with a monitor which has a VGA connector.</td>
<td></td>
</tr>
<tr>
<td>Software Entitlement Certificates</td>
<td>Redemption certificates for the measurement options purchased.</td>
<td></td>
</tr>
</tbody>
</table>
Shipping problems?

If the shipping materials are damaged or the contents of the container are incomplete:

- Contact the nearest Keysight Technologies office.
- Keep the shipping materials for the carrier’s inspection.
- If you must return an test set to Keysight Technologies, use the original (or comparable) shipping materials. See “Returning a test set for Service” on page 183.

<table>
<thead>
<tr>
<th>Item</th>
<th>Deliverable</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power cable</td>
<td>Connection for test set power.</td>
<td></td>
</tr>
</tbody>
</table>
Test Set Location and Mounting Requirements

Locating the test set

Make sure that the fan inlet and exhaust vent areas on the sides, bottom, and back of the test set chassis are not obstructed. The minimal required clearance is 1 inch (25 cm). Airflow restrictions cause additional airflow noise and cause the fans to speed up so they can draw in enough air for the required cooling resulting in excessive audible noise.

It is recommended to orient the instrument horizontally (as illustrated below), not vertically, and at least half a meter above the floor.

Cooling and rack mounting

Do not mount the test set side-by-side with any other instrument with side-by-side ventilation. Make sure the exhaust air from one instrument is directed away from the inlet of any other instrument (heated air directed into the inlet of an instrument can cause instrument failure due to excessive operating temperatures). The test set draws air in from the sides and bottom of the chassis and exhausts air from the back.

Figure 1-4  EXM front panel view
Separate Application Interfaces

There are two different interfaces for test applications which run on the EXM. The interfaces are launched separately, using either the LaunchXSA or LaunchXSA MultiTouch icons on the desktop. (The two interfaces cannot run simultaneously.)

Many EXM setup procedures are performed differently, depending on which of the two interfaces is running. Alternative procedures are included in this manual at several points for that reason.

The interface associated with the LaunchXSA icon is illustrated below.

Figure 1-5 XSA interface
Quick-Start
Separate Application Interfaces

The interface associated with the LaunchXSA MultiTouch icon is illustrated below.

Figure 1-6  XSA MultiTouch interface

At present, only the 5G NR and Sequence Analyzer modes run in the XSA MultiTouch interface; other measurement modes will be incorporated in later releases.
Quick-Start
Turning on the test set the first time

Turning on the test set the first time

During the initial power-on process, the test set turns off and restarts several times. This only happens during the initial installation process.

Initializing the test set using a USB mouse and external monitor

The turn-on procedure given here assumes that the interface invoked by the LaunchXSA icon is used initially, not the interface invoked by the LaunchXSA MultiTouch icon.

<table>
<thead>
<tr>
<th>Steps</th>
<th>Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Connect a mouse and keyboard</td>
<td>Connect the mouse and keyboard to two of the USB ports on the front panel of the test set.</td>
</tr>
<tr>
<td>2</td>
<td>Connect a monitor</td>
<td>Connect the monitor to the monitor port on the front panel of the test set. Model E6640A has no display; an external monitor is required. See “Virtual Front Panel” on page 28.</td>
</tr>
<tr>
<td>3</td>
<td>Power on the test set</td>
<td>Position the test set so you have easy access to the power cord and plug it in. Press the power switch (located near the top right corner of the PXI rack) to turn the test set on. See “Test Set Location and Mounting Requirements and “Power requirements” on page 24 for more details. The test set can require more than 5 minutes to power-on. This is affected by Windows start-up requirements. The Keysight Technologies screen appears.</td>
</tr>
<tr>
<td>4</td>
<td>Launch Microsoft Setup Wizard</td>
<td>Highlight Microsoft Windows and press Enter to start the pre-installed operating system. At this time, it is safe to turn off the test set before starting the Setup Wizard.</td>
</tr>
</tbody>
</table>
Quick-Start
Turning on the test set the first time

<table>
<thead>
<tr>
<th>Steps</th>
<th>Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The analyzer performs the following steps:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Windows Startup window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Black screen</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Windows message window, “Please wait while windows prepares to setup”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Keysight window</td>
<td></td>
</tr>
<tr>
<td></td>
<td>At this time, it is safe to turn off the instrument before initializing the software.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAUTION</td>
<td></td>
</tr>
<tr>
<td></td>
<td>After launching the setup, do not turn off the instrument or remove power before the Setup Wizard completes and the system restarts. Turning off the instrument may corrupt the system and the application may not operate.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Reboot and log on</td>
<td>Click <strong>OK</strong>. When the instrument restarts, the following message window appears:</td>
</tr>
<tr>
<td></td>
<td>The system reboots.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Several required processes continue.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The system reboots.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The XSA application initializes</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Separate instances of the application are launched for each TRX installed in the PXI rack (they are identified as “TRX1” through “TRX4” in the upper left corner of the application window). The verification procedures which follow should be done for all TRXs in the rack.</td>
<td></td>
</tr>
</tbody>
</table>
## Quick-Start

Turning on the test set the first time

<table>
<thead>
<tr>
<th>Steps</th>
<th>Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Verify the installation</td>
<td>From the mouse right-click menu, select <strong>Utility, Virtual Front Panel</strong>. (All key-presses that follow refer initially to a key shown on the Virtual Front Panel, and then to whatever menu keys that key makes available.) Press <strong>System, Show, System</strong>. Verify that the purchased application(s) appear in the list. If you require further assistance, contact the Keysight support team. Online assistance: <a href="http://www.keysight.com/find/assist">http://www.keysight.com/find/assist</a></td>
</tr>
<tr>
<td>8</td>
<td>Attach a loopback cable</td>
<td>Use an RF cable to connect the front panel RFIO 1 and RFIO 2 ports for this TRX. The purpose is to use a loopback cable to verify that the test set's source can generate a signal and the test set's analyzer can measure it.</td>
</tr>
<tr>
<td>9</td>
<td>Generate and view a signal</td>
<td>Press <strong>Input/Output, RF Input, RF Input Port, RFIO 1</strong>. Press <strong>Input/Output, More, RF Output &amp; Test Set Config, RF Output Port, RFIO 2</strong>. Press <strong>AMPTD Y Scale, Ref Value, 10 dBm</strong>. Set the amplitude reference to 10 dBm. Press <strong>FREQ, Center Freq, 2.4, GHz</strong>. Set the analyzer center frequency to 2.4 GHz. Press <strong>SPAN X Scale, Span, 8, MHz</strong>. Set the analyzer span to 8 MHz. Press <strong>Source, Frequency, 2.4, GHz</strong>. Set the source frequency to 2.4 GHz. Press <strong>Source, RF Output, On</strong>. Set the source RF output to On. Press <strong>Source, Amplitude, RF Power, -15 dBm</strong>. Set the source amplitude to -15 dBm. Press <strong>Peak Search</strong>. To ensure accurate power levels from the source, see “Alignments” on page 36.</td>
</tr>
</tbody>
</table>

Select RFIO 1 as the input port
Select RFIO 2 as the output port.
### Quick-Start
Turning on the test set the first time

<table>
<thead>
<tr>
<th>Steps</th>
<th>Actions</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The 2.4 GHz signal appears on the display.</td>
<td></td>
</tr>
</tbody>
</table>
Options and Licenses

The options and licenses installed on the test set are listed on the **System > Show > System** display, as illustrated below. Certain features of the test set (such as its frequency range, its analysis bandwidth, the measurement applications it runs, and in some cases individual measurements within an application) are licensed features, and are unavailable if the appropriate license is not installed.

**Figure 1-7  Checking options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Name / Description</th>
<th>Option Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>E6640A-PDX</td>
<td>Intel(R) Core(TM) i7-4700EQ CPU @ 2.40GHz, 16 GB</td>
<td></td>
</tr>
<tr>
<td>E6640A-SSD</td>
<td>INTEL SSDSC2BB240G4 SSD DISK DEVICE</td>
<td></td>
</tr>
<tr>
<td>E6640A-W2X</td>
<td>Microsoft Windows Embedded Standard, 64 bit OS</td>
<td></td>
</tr>
<tr>
<td>Y9077B-1MP</td>
<td>WLAN 802.11ac Measurement</td>
<td>1.3.58421.1</td>
</tr>
<tr>
<td>Y9077B-WFP</td>
<td>WLAN 802.11ac Wave2 Measurement Application</td>
<td>1.3.58421.1</td>
</tr>
<tr>
<td>Y9090B-1FP</td>
<td>LTE Measurement Application</td>
<td>1.3.58421.1</td>
</tr>
<tr>
<td>Y9090B-2FP</td>
<td>LTE-Adv FDD Measurement Application</td>
<td>1.3.58421.1</td>
</tr>
<tr>
<td>Y9080B-BFP</td>
<td>LTE Feature Enhancements</td>
<td>1.3.58421.1</td>
</tr>
<tr>
<td>Y9081B-3FP</td>
<td>Bluetooth 5 Measurement Application</td>
<td>- -</td>
</tr>
<tr>
<td>Y9085EM0E</td>
<td>5G NR Measurement Application</td>
<td>- -</td>
</tr>
</tbody>
</table>

**NOTE**

Hardware-related options such as frequency range and analysis bandwidth are specific to the TRX; measurement applications apply to any TRX in the same test set chassis.

For many of the measurement applications, the license is listed here in separate “A” and “B” versions. For example, when the “Y9071B-2FP” license is purchased and installed, the “Y9071A-2FP” license is automatically installed along with it. This is not an error; both versions of the license should be present.
Option 2FD

Option 2FD modifies the RFIO interface of the E6640A EXM Wireless Test Set as follows:

- Each TRX in the test set has a model designation M9432A.
- Ports RFIO 1 and RFIO2 are full-duplex ports (simultaneously inputs and outputs). Ports RF3 I/O and RF4 I/O are half-duplex ports (they can be inputs or outputs, but not simultaneously).
- Performance characteristics for the four ports are described in the E6640A EXM Wireless Test Set Data Sheet.
- Port settings under the **Input/Output** menu (and equivalent SCPI commands) are modified to reflect the option installed.

See “Port Configuration” on page 106 for more information about port setup in connection with the 5G NR application. See “Port Configuration” on page 60 for more information about port setup in connection with other applications.

Option 4FD

Option 4FD modifies the RFIO interface of the E6640A EXM Wireless Test Set as follows:

- Each TRX in the test set has a model designation M9433A.
- All four ports (RFIO 1, RFIO 2, RFIO 3, and RFIO 4) on each module are full-duplex ports (that is, any port can be used simultaneously as an RF input (to the test set’s analyzer) and as an RF output (from the test set’s source).
- Any of the TRX’s four RFIO ports can be configured as a full duplex port; it can also be configured as an input port (accepting a signal to be analyzed), with a separate port configured as an output port (providing an RF stimulus).
- Performance characteristics for all four ports are same as those described for ports RFIO 1 and RFIO 2 in the E6640A EXM Wireless Test Set Data Sheet.
- Port settings under the **Input/Output** menu (and equivalent SCPI commands) are modified to reflect the option installed.

See “Port Configuration” on page 106 for more information about port setup in connection with the 5G NR application. See “Port Configuration” on page 60 for more information about port setup in connection with other applications.

Option 5B0

M9433A TRX modules with Option 5B0 adds the frequency bands required for sub-6 GHz 5G NR testing in the 380 MHz to 6 GHz range.
Anti-Virus Software and Firewalls

No anti-virus software is shipped with the test set. It is recommended that you install anti-virus software if your test set is connected to the LAN. Check with your IT department to see what they recommend.

The test set is shipped with the Windows firewall enabled. Do not modify the default network settings as this may cause problems with the operating system of the test set.

Keysight recommends installing Windows updates. This should be enabled in Windows security settings.

Shortening the Test Set Power-On Time

The test set desktop includes a shortcut to the ConfigureApplications.exe application that lets you control your test set power-on configuration. You can set the configuration to pre-load only the applications that you typically run. This can significantly shorten the time it takes for your test set to power-on. You can also access this functionality by pressing: System, Power On, Configure Applications. (These key-presses refer to the Virtual Front Panel; see “Virtual Front Panel” on page 28.)

If (after power-on) you want to access an application that you did not pre-load, it will take a little longer to bring it up once you press the application softkey. This longer time-frame is only for the first access after power-on. After the initial access, mode (application) switching will operate as quickly as if the application was pre-loaded.
Instrument Safety & Environmental Information

Power requirements

The only physical installation of your Keysight test set is a connection to a power source. Line voltage does \textbf{not} need to be selected.

This test set does \textbf{not} contain customer serviceable fuses.

\textbf{WARNING}

This is a Safety Class 1 Product (provided with a protective earthing ground incorporated in the power cord). The mains plug shall only be inserted in a socket outlet provided with a protective earth contact. Any interruption of the protective conductor inside or outside of the product is likely to make the product dangerous. Intentional interruption is prohibited. (IEC 348 clauses 17.3.3c & 17.3.4)

Failure to ground the test set properly can result in personal injury. Before turning on the test set, you must connect its protective earth terminals to the protective conductor of the main power cable. Insert the main power cable plug into a socket outlet that has a protective earth contact only. DO NOT defeat the earth-grounding protection by using an extension cable, power cable, or autotransformer without a protective ground conductor.

\textbf{WARNING}

This product is designed for use in Installation Category II and Pollution Degree 2.

This instrument has autoranging line voltage input. Before switching on the instrument, be sure the supply voltage is within the specified range.

The Mains wiring and connectors shall be compatible with the connector used in the premise electrical system. Failure, to ensure adequate earth grounding by not using the correct components may cause product damage, and serious injury.
Quick-Start
Instrument Safety & Environmental Information

AC power cord
The test set is equipped with a three-wire power cord, in accordance with international safety standards. This cable grounds the test set cabinet when connected to an appropriate power line outlet. The cable appropriate to the original shipping location is included with the test set. See:

http://www.keysight.com/find/powercords

CAUTION
Always use the three-prong AC power cord supplied with this product. Failure to ensure adequate earth grounding by not using this cord can cause product damage.

This instrument has auto-ranging line voltage input; be sure the supply voltage is within the specified range and voltage fluctuations do not to exceed 10 percent of the nominal supply voltage:
100/120 VAC 50/60 Hz, 1000 W MAX
220/240 VAC 50/60 Hz, 1200 W MAX.

WARNING
If this product is not used as specified, the protection provided by the equipment could be impaired. This product must be used in a normal condition (in which all means for protection are intact) only. Install the instrument so that the detachable power cord is readily identifiable and easily reached by the operator. The detachable power cord is the instrument disconnecting device. It disconnects the mains circuits from the mains supply before other parts of the instrument. The front panel switch is only a standby switch and is not a LINE switch. Alternatively, an externally installed switch or circuit breaker (which is readily identifiable and is easily reached by the operator) may be used as a disconnecting device.

Environmental Conditions (Operating)
This product is designed for use in the following conditions:

- For indoor use only
- Temperature 5°C to 45°C
- Altitude up to 3048 meters
- 0% Relative Humidity to 90% Relative Humidity up to 40°C, and linearly decreasing to 50% Relative Humidity up to 45°C; non-condensing.

CAUTION
This product is designed for use in Installation Category II and Pollution Degree 2.
Quick-Start
Instrument Safety & Environmental Information

Ventilation

**CAUTION**
VENTILATION REQUIREMENTS: When installing the product in a cabinet, the convection into and out of the product must not be restricted. The ambient temperature (outside the cabinet) must be less than the maximum operating temperature of the product by 4°C for every 100 watts dissipated in the cabinet. If the total power dissipated in the cabinet is greater than 800 watts, then forced convection must be used.

Instrument Maintenance

**Cleaning the instrument**
To prevent electrical shock, disconnect the test set from mains before cleaning. Use a dry cloth or one slightly dampened with water to clean the external case parts. Do not attempt to clean internally.

**Cleaning the connectors**
Cleaning connectors with alcohol shall only be done with the instrument power cord removed, and in a well-ventilated area. Allow all residual alcohol moisture to evaporate, and the fumes to dissipate prior to energizing the instrument.
Battery Information

The test set uses a lithium battery located on the CPU board. This is not an operator replaceable part. See “Returning a test set for Service” on page 183. Replaceable parts must be approved or supplied by Keysight Technologies.

You can order the service documentation for the instrument through your Keysight Sales and Service office.

**WARNING**

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended. Discard used batteries according to the manufacturer’s instructions.

Do not throw batteries away but collect as small chemical waste.
Protecting against electrostatic discharge

Electrostatic discharge (ESD) can damage or destroy electronic components (the possibility of unseen damage caused by ESD is present whenever components are transported, stored, or used).

Test equipment and ESD

To help reduce ESD damage that can occur while using test equipment:

- Before connecting any coaxial cable to a test set connector for the first time each day, momentarily short the center and outer conductors of the cable together.
- Personnel should be grounded with a 1 MΩ resistor-isolated wrist-strap before touching the center pin of any connector and before removing any assembly from the test set.
- Be sure that all instruments are properly earth-grounded to prevent build-up of static charge.
- Perform work on all components or assemblies at a static-safe workstation.
- Keep static-generating materials at least one meter away from all components.
- Store or transport components in static-shielding containers.
- Always handle printed circuit board assemblies by the edges. This reduces the possibility of ESD damage to components and prevent contamination of exposed plating.

Additional information about ESD

For more information about ESD and how to prevent ESD damage, contact the Electrostatic Discharge Association (http://www.esda.org). The ESD standards developed by this agency are sanctioned by the American National Standards Institute (ANSI).
2 Front and Rear Panel Features

The following topics can be found in this section:

“Front Panel Features” on page 30
“Rear Panel Features” on page 43
“Front and Rear Panel Symbols” on page 44
Front Panel Features

The test set consists of instruments loaded in a PXI rack, hidden behind a front panel. There is a controller (located on the far left), and one to four TRX (transmit/receive) sub-instruments, each of which includes an RF signal generator and an RF signal analyzer. A frequency-reference instrument, shared by all the TRX sub-instruments, is placed in the center.

Figure 2-1 EXM Front Panel
Controller Hardware Interface

The controller's front panel features are illustrated below:

**Figure 2-2 Controller front panel**

<table>
<thead>
<tr>
<th>Number</th>
<th>Item Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Monitor Port</td>
<td>This connector supports a connection to a monitor with a DisplayPort input.</td>
</tr>
</tbody>
</table>
| 2      | LED Indicators| – DRIVE: When the Solid State Drive is active, the LED will flash.  
– POWER: If the LED is on, the power supply to the controller is good and the system should boot.  
– USER: Not used. |
| 3      | TRIG        | This trigger line is not used by the E6640A.                                                                                                   |
### Front and Rear Panel Features

#### Front Panel Features

<table>
<thead>
<tr>
<th>Number</th>
<th>Item Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>LAN Connectors</td>
<td>Two TCP/IP Interface connectors that are used for remote test set operation. Choose the LAN 1 port to have an IP address assigned to the test set dynamically, using DHCP. If your local network does not support DHCP, choose the LAN 2 port to use a private static IP address. (See &quot;LAN Address Configuration&quot; on page 71.)</td>
</tr>
<tr>
<td>5</td>
<td>USB 3.0</td>
<td>The controller provides two USB 3.0 ports.</td>
</tr>
<tr>
<td>6</td>
<td>USB 2.0</td>
<td>The controller provides four USB 2.0 ports.</td>
</tr>
</tbody>
</table>
TRX Module Hardware Interface

There can be as many as four TRX modules in the PXI rack; each has the same hardware interface, as illustrated below.

**NOTE** If the E6640A test set was purchased with Option 4FD, all four RF ports have full-duplex capability, therefore two of the ports are labeled and used differently than they are described below. See “Option 4FD” on page 14.

---

**Figure 2-3** TRX module front panel

<table>
<thead>
<tr>
<th>Number</th>
<th>Item Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TRXn STATUS</td>
<td>When the PXI chassis is powered on, the STATUS LED for each TRX module lights red when the software application controlling the TRX hardware begins loading. When the software application is done loading, the LED will be green the TRX will be ready for use.</td>
</tr>
<tr>
<td>2</td>
<td>RFIO 2</td>
<td>This Type N connector is a full-duplex RF input/output port.</td>
</tr>
<tr>
<td>3</td>
<td>RFIO 1</td>
<td>This Type N connector is a full-duplex RF input/output port.</td>
</tr>
</tbody>
</table>
### Front Panel Features

<table>
<thead>
<tr>
<th>Number</th>
<th>Item Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>TRIG OUT 2</td>
<td>A trigger output used to synchronize other test equipment with the test set. Configurable from the Input/Output keys.</td>
</tr>
<tr>
<td>5</td>
<td>TRIG IN 1</td>
<td>A trigger input used to synchronize other test equipment with the test set. Configurable from the Input/Output keys.</td>
</tr>
<tr>
<td>6</td>
<td>RF4 I/O</td>
<td>This Type N connector is a half-duplex RF port which can be configured as an input or an output. (If Option 4FD is installed, see “Option 2FD” on page 22.)</td>
</tr>
<tr>
<td>8</td>
<td>RF3 I/O</td>
<td>This Type N connector is a half-duplex RF port which can be configured as an input or an output. (If Option 4FD is installed, see “Option 2FD” on page 22.)</td>
</tr>
<tr>
<td>9</td>
<td>TRIG OUT 1</td>
<td>A trigger output used to synchronize other test equipment with the test set. Configurable from the Input/Output keys.</td>
</tr>
<tr>
<td>10</td>
<td>TRIG IN 2</td>
<td>A trigger input used to synchronize other test equipment with the test set. Configurable from the Input/Output keys.</td>
</tr>
</tbody>
</table>
Reference Module Hardware Interface

The connectors which are exposed when the impact cover is in place are illustrated below:

**Figure 2-4** Reference module front panel

<table>
<thead>
<tr>
<th>Number</th>
<th>Item Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10 MHz OUT</td>
<td>This BNC input port provides a timebase reference output from the M9300A Reference module.</td>
</tr>
<tr>
<td>2</td>
<td>REF IN</td>
<td>This BNC input port accepts a timebase reference input to the Ref In port of the M9300A Reference module.</td>
</tr>
</tbody>
</table>
Virtual Front Panel

The E6640A model does not include physical front-panel keys. However, if you have a PC mouse, monitor, and keyboard plugged in (or are working through a Remote Desktop interface), you can navigate front-panel functions using the virtual front panel (VFP) shown below. Access the VFP as follows:

1. Right-click the mouse.
2. Left-click Utility (1) in the menu, as shown below.
3. Left-click Virtual Front Panel (2) in the menu, as shown below.

The PC mouse and monitor are required when using the E6640A. For ease in using the VFP, the PC keyboard is recommended.

On the VFP the keys labeled "SoftKey 1" through "SoftKey 7" function as the menu keys. Using the mouse to click on a combination of the VFP keys and the menu keys on the display screen, you can operate the instrument as if it had conventional front-panel keys. The VFP frame shows “Left” or “Right” at the upper left corner of the frame, so that it’s clear which sub-instrument within the PXI rack is being controlled by it.
Figure 2-6  Virtual front panel keys
When the Test Set is Controlled Remotely

The test set can be controlled remotely, from another computer. (See “Remote Desktop: Using the Test Set Remotely” on page 147.) When the test set is being controlled remotely, a log-on screen is displayed on the monitor. Under these circumstances, pressing the front-panel Power switch does not immediately turn instrument power off. Instead, the following message appears:

Other people are logged on to this computer. Shutting down windows might cause them to lose data. Do you want to continue shutting down?

Although pressing and holding down the Power button will force a power shutdown, this is not recommended; use the Windows shutdown function instead.

WARNING

Do not shut down power by pulling out the power plug; this will damage the power supply.
Display Annotations (XSA interface)

Figure 2-7  Display annotations (XSA interface)

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Function Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Measurement bar; shows general measurement settings and information. Some measurements include limits which the data is tested against. A Pass/Fail indication may be shown in the lower-left corner. The following graphics indicate single/continuous measurement:</td>
<td>All the keys in the test set Setup part of the front panel.</td>
</tr>
<tr>
<td>2</td>
<td>Active Function (measurement bar); when the current active function has a settable numeric value, it is shown here.</td>
<td>Currently selected front panel key.</td>
</tr>
<tr>
<td>3</td>
<td>The TRX sub-instrument associated with the application (identified as “TRX1” through “TRX4”). This is needed because the E6640A can include up to four independent TRX sub-instruments in one PXI rack.</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>Description</td>
<td>Function Key</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td>4</td>
<td>Banner; shows the name of the selected application that is currently running.</td>
<td>Mode</td>
</tr>
<tr>
<td>5</td>
<td>Measurement title; shows title information for the current measurement, or a title that you created for the measurement.</td>
<td>Meas View/Display, Display, Title</td>
</tr>
<tr>
<td>6</td>
<td>Settings panel; displays system information that is not specific to any one application.</td>
<td>Local and System, I/O Config, Input/Output, Amplitude, System, and others</td>
</tr>
<tr>
<td></td>
<td>- Input/Output status - green LXI indicates the LAN is connected. RLTS indicate Remote, Listen, Talk, SRQ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Input impedance and coupling</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Selection of external frequency reference</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Setting of automatic internal alignment routine</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Active marker frequency, amplitude, or function value</td>
<td>Marker</td>
</tr>
<tr>
<td>8</td>
<td>Settings panel; time and date display</td>
<td>System, Control Panel</td>
</tr>
<tr>
<td>9</td>
<td>Trace and detector information</td>
<td>Trace/Detector, Clear Write (W) Trace Average (A) Max Hold (M) Min Hold (m) Trace/Detector, More, Detector, Average (A) Normal (N) Peak (P) Sample (S) Negative Peak (p)</td>
</tr>
<tr>
<td>10</td>
<td>Key labels that change based on the most recent key press</td>
<td>Softkeys</td>
</tr>
<tr>
<td>12</td>
<td>Measurement settings for the data currently being displayed in the graticule area. In the example above: center frequency, resolution bandwidth, video bandwidth, frequency span, sweep time and number of sweep points.</td>
<td>Keys in the test set Setup part of the front panel.</td>
</tr>
</tbody>
</table>
### Display Annotations (XSA MultiTouch interface)

**Figure 2-8** Display annotations (XSA MultiTouch interface)

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The TRX sub-instrument associated with the application (identified as “TRX1” through “TRX4”).</td>
<td>This is needed because the E6640A can include up to four independent TRX sub-instruments in one PXI rack.</td>
</tr>
<tr>
<td>2</td>
<td>Screen tab. Shows mode and measurement selected for that tab.</td>
<td>To change the selection, click on the tab to open the Mode/Meas/View dialog.</td>
</tr>
<tr>
<td>3</td>
<td>Add another screen tab.</td>
<td>Click to add another screen tab for this TRX; can be set to another mode and measurement.</td>
</tr>
<tr>
<td>4</td>
<td>Measurement bar.</td>
<td>Shows the most important parameters for the measurement.</td>
</tr>
<tr>
<td>5</td>
<td>System Settings icon.</td>
<td>Click to open a complex System Settings window, which provides access to many settings which are independent of a particular measurement (alignments, for example).</td>
</tr>
</tbody>
</table>

#### Notes

- **Number**: The numbering in the diagram corresponds to the numbers in the table. Each number is labeled with a red arrow in the diagram.
- **Description**: The description of each feature is listed in the table.
- **Notes**: Additional notes about each feature are provided in the table.
- **Figure 2-8**: The figure shows the display annotations (XSA MultiTouch interface) with labels for each feature.
# Front and Rear Panel Features

## Front Panel Features

<table>
<thead>
<tr>
<th>Number</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Preset icon.</td>
<td>Access to presets and defaults.</td>
</tr>
<tr>
<td>8</td>
<td>Left side of measurement bar; includes display of pass/fail result, plus single/continuous measurement selection and indicator.</td>
<td>The following graphics indicate single/continuous measurement: 🔄 ➤ ●</td>
</tr>
<tr>
<td>9</td>
<td>Measurement results.</td>
<td>Graphs plus numerical tables; the number and type of displays is determined by the measurement that is running.</td>
</tr>
<tr>
<td>10</td>
<td>Undo/Redo icons.</td>
<td>Undo the last executed function, or redo the last undone function.</td>
</tr>
<tr>
<td>11</td>
<td>Windows icon.</td>
<td>Open the Windows Start menu and taskbar.</td>
</tr>
<tr>
<td>12</td>
<td>File icon.</td>
<td>Access to a variety of file-related functions, including Save and Recall.</td>
</tr>
<tr>
<td>13</td>
<td>Help icon.</td>
<td>Open the help content. To dismiss the help, use the ESC key or the X at the upper right of the help screen.</td>
</tr>
<tr>
<td>14</td>
<td>Status window.</td>
<td>Displays status messages.</td>
</tr>
<tr>
<td>15</td>
<td>Block diagram.</td>
<td>Opens a graphical representation of internal hardware and signal paths. Individual blocks can be clicked to open related menus.</td>
</tr>
<tr>
<td>16</td>
<td>View editor.</td>
<td>Opens an editor for adding and deleting windows, resizing and rearranging windows, and creating User Views.</td>
</tr>
<tr>
<td>17</td>
<td>Multiscreen icon.</td>
<td>Displays all the existing screen tabs simultaneously, in multiple windows.</td>
</tr>
<tr>
<td>18</td>
<td>Fullscreen icon.</td>
<td>Expand the measurement window horizontally over the entire instrument display. The screen graticule area expands to fill the available display area.</td>
</tr>
</tbody>
</table>
### Rear Panel Features

#### Figure 2-9 EXM rear panel

<table>
<thead>
<tr>
<th>Number</th>
<th>Item Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Line power input</td>
<td>The AC power connection. See the product specifications for more details.</td>
</tr>
<tr>
<td>2</td>
<td>POWER SYNCH IN/OUT</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>3</td>
<td>FAN</td>
<td>Fan speed control (settings are HIGH and AUTO).</td>
</tr>
<tr>
<td>4</td>
<td>INHIBIT</td>
<td>Inhibit switch. The settings are DEF (default) and MAN (manual).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– When the switch is in the default position, the chassis is powered up by the front panel ON/Standby pushbutton. This is the recommended setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– When the switch is in the manual position, the chassis is powered up by the Inhibit input signal on the rear panel INHIBIT/VOLTAGE MON DB-9 connector.</td>
</tr>
<tr>
<td>5</td>
<td>INHIBIT/VOLTAGE MON</td>
<td>This DB-9 connector provides access for testing of internal power supply voltages. The voltages (by Pin #) are: (1) Logic Gnd, (2) +5 VDC, (3) Rsrvd, (4) +3.3 VDC, (5) Inhibit [Low], (6) +12 VDC, (7) Rsrvd, (8) -12 VDC, (9) Logic Gnd.</td>
</tr>
<tr>
<td>6</td>
<td>10 MHz REF OUT</td>
<td>This BNC connector is not used by the E6640A test set. The front panel 10 MHz OUT connector should be used instead.</td>
</tr>
<tr>
<td>7</td>
<td>10 MHz REF IN</td>
<td>This BNC connector is not used by the E6640A test set. The front panel REF IN connector should be used instead.</td>
</tr>
</tbody>
</table>
### Front and Rear Panel Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power ON" /></td>
<td>This symbol is used to indicate power ON.</td>
</tr>
<tr>
<td><img src="image" alt="Power OFF" /></td>
<td>This symbol is used to indicate power OFF.</td>
</tr>
<tr>
<td><img src="image" alt="Power STANDBY" /></td>
<td>This symbol is used to indicate power STANDBY mode (yellow in standby, green when instrument is ON).</td>
</tr>
<tr>
<td><img src="image" alt="AC" /></td>
<td>This symbol indicates the input power required is AC.</td>
</tr>
<tr>
<td><img src="image" alt="Ground" /></td>
<td>This symbol indicates earth ground.</td>
</tr>
<tr>
<td><img src="image" alt="Instruction Documentation" /></td>
<td>The instruction documentation symbol. The product is marked with this symbol when it is necessary for the user to refer to instructions in the documentation.</td>
</tr>
<tr>
<td><img src="image" alt="CE" /></td>
<td>The CE mark is a registered trademark of the European Community.</td>
</tr>
<tr>
<td><img src="image" alt="Keysight Email" /></td>
<td>The Keysight email address is required by EU directives applicable to our product.</td>
</tr>
<tr>
<td><img src="image" alt="RCM" /></td>
<td>The RCM mark is a registered trademark of the Australian Communications and Media Authority.</td>
</tr>
<tr>
<td><img src="image" alt="Korean Certification" /></td>
<td>South Korean Certification (KC) mark; includes the marking’s identifier code which follows this format: MSIP-REM-YYY-ZZZZZZZZZZZZZZ</td>
</tr>
<tr>
<td><img src="image" alt="ICES/NMB-001" /></td>
<td>ICES / NMB-001 Cet appareil ISM est conforme a la norme NMB du Canada. This is a marking to indicate product compliance with the Industry Canadian Interference-Causing Equipment Standard (ICES-001). This is also a symbol of an Industrial Scientific and Medical Group 1 Class A product (CISPR 11, Clause 4).</td>
</tr>
<tr>
<td><img src="image" alt="CSA" /></td>
<td>The CSA mark is a registered trademark of the CSA International.</td>
</tr>
</tbody>
</table>
### Front and Rear Panel Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Symbol" /></td>
<td>This symbol indicates separate collection for electrical and electronic equipment mandated under EU law as of August 13, 2005. All electric and electronic equipment are required to be separated from normal waste for disposal (Reference WEEE Directive 2002/96/EC).</td>
</tr>
<tr>
<td><img src="image2.png" alt="Symbol" /></td>
<td>Indicates the time period during which no hazardous or toxic substance elements are expected to leak or deteriorate during normal use. Forty years is the expected useful life of the product.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Symbol" /></td>
<td>This symbol indicates compliance with the China RoHS regulations for paper/fiberboard packaging.</td>
</tr>
</tbody>
</table>
3 XSA Interface

The following topics can be found in this section:

“Distinguishing the Interfaces” on page 48
“Alignments” on page 49
“TRX Selection” on page 51
“E6640A Calibration Status” on page 53
“Desktop Icons” on page 55
“Port Configuration” on page 60
“LAN Address Configuration” on page 71
“Switched MIMO” on page 72
“True MIMO” on page 79
“Tx Beam Forming” on page 91
Distinguishing the Interfaces

Most test applications in the E6640A run in the XSA interface (illustrated on the left below); the 5G NR application runs in the newer XSA MultiTouch UI (illustrated on the right below). The most visible difference between the interfaces is in the menus in the rightmost column of the display.

The XSA interface relies on a combination of submenus and a Virtual Front Panel popup window. The XSA MultiTouch UI operates primarily by opening temporary configuration screens for each settable parameter.

This chapter is devoted to the XSA interface; see Chapter 4, “XSA MultiTouch Interface”, on page 93 for information on the other interface.
Alignments

Alignments are internal calibration adjustments which each TRX module must make to ensure that internal signal levels are properly maintained. To avoid interruptions, the alignments are not run automatically, either at startup or afterward; you must run them explicitly.

“All” Alignment (daily use)

This alignment of the source and analyzer in the TRX is sufficient to maintain specified performance, provided that (1) the TRX’s internal temperature has not drifted more than 5 degrees C since the previous alignment, (2) no more than 8 hours have elapsed since the previous “All” alignment, and (3) no more than 1 week has elapsed since the previous weekly alignment (see below). The “All” alignment typically takes less than 5 minutes to run.

The TRX’s internal temperature can be checked by sending the SCPI query :CAL:TEMP:CURR?

To run the alignment, select System > Alignments > Align Now > All, or send the SCPI command :CAL:ALL.

NOTE

The alignment process requires a 45-minute preliminary warm-up period, after applying power or after restarting the XSA application (when the application is not running, power is not applied to the TRXs; therefore an application shutdown has the same effect on alignment as a power shutdown).
Weekly alignment procedure

A more thorough alignment of the source and analyzer in the TRX is required on a weekly basis. This procedure is similar to the "All" alignment described above, but it also performs additional alignment functions related to slow-drifting parameters which do not change significantly over time periods shorter than a week.

1. Select System > Alignments > Align Now > IF, or send the SCPI commands:
   :CAL:IF
   *WAI

2. Select System > Alignments > Align Now > RF, or send the SCPI commands:
   :CAL:RF
   *WAI

3. Select System > Alignments > Align Now > Source, or send the SCPI commands:
   :CAL:SOUR
   *WAI

This alignment process also requires the same 45-minute preliminary warm-up period described under “"All" Alignment (daily use)” on page 49.
TRX Selection

On the monitor or remote desktop view of the test set, each TRX is represented by a separate XSA window. You can identify which TRX a window controls by looking for the identifier (TRX1 through TRX4 for a fully loaded system) at the top left corner of the window. (The TRXs are placed in numerical order in the PXIe chassis, beginning with TRX1 on the left.)

Figure 3-3  Identifying application windows for different TRXs

Although the test set as a whole is assigned only one IP address for the entire PXIe chassis, the individual TRXs within the chassis can be differentiated in network communication with the test set. The means of identifying a TRX depends upon the connection method, as outlined below.

Using HiSLIP

HiSLIP (High-Speed LAN Instrument Protocol) is the recommended interface for connection to the E6640A, because of its superior performance characteristics.

Use hislip0 through hislip3:

- TRX1:
  TCPIP0::<IP Address>::hislip0::INSTR
- TRX2:
  TCPIP0::<IP Address>::hislip1::INSTR
- TRX3:
  TCPIP0::<IP Address>::hislip2::INSTR
- TRX4:
  TCPIP0::<IP Address>::hislip3::INSTR
Using Socket Ports

Use sockets 5025, 5125, 5225, and 5325:

Using VXI-11/SICL

Use inst0 through inst3:

- **TRX1:**
  TCPIP0::<IP Address>::inst0::INSTR
- **TRX2:**
  TCPIP0::<IP Address>::inst1::INSTR
- **TRX3:**
  TCPIP0::<IP Address>::inst2::INSTR
- **TRX4:**
  TCPIP0::<IP Address>::inst3::INSTR

Using Telnet Connection

Use telnet ports 5023, 5123, 5223, 5323:

- **TRX1:**
  5023
- **TRX2:**
  5123
- **TRX3:**
  5223
- **TRX4:**
  5323
E6640A Calibration Status

The E6640A EXM test set does not have a calibration certificate, because of its flexibility in configuration:

– The E6640A chassis can have 1, 2, 3, or 4 TRXs (M943xA) installed.
– Different TRXs can have different hardware configurations for frequency range and/or bandwidth.
– Additional TRXs can be added to an E6640A chassis after the initial instrument purchase. These would have different calibration due dates, and different warranty end dates, from the modules that were originally purchased with the E6640A.

There isn’t a single instrument-level calibration (or calibration due-date) that covers the E6640A as a whole and all of the TRX modules (and the Reference module) within it. Each module is calibrated independently, and not necessarily at the same time that the others in the test set are calibrated.

The only way to track the calibration status of the E6640A is to track the calibration status of the reference module, and each TRX module, within it. The serial number of a particular module can be found from its XSA window, by selecting **System > Show > Hardware** on the Virtual Front Panel. The serial number is listed in the row which shows “Reference” or “M943x TRX” under Assembly Name. The same row also shows the Cal Date and Cal Interval for the relevant module.

The same hardware information is also returned by the SCPI command: **SYST:CONF:HARD?**
Certificates of Calibration

Customers receive 2 to 5 Certificates of Calibration (COCs) with the E6640A EXM test set. The EXM is a scalable test set and can be purchased with 1 to 4 TRX modules. The TRX modules, along with the Reference module (supplied with each E6640A), are the only items that require calibration, and therefore they are the only items supplied with a CoC and calibration sticker at shipment.

Each E6640A test set is shipped with a yellow envelope which contains your calibration certificates; this envelope is labeled (lower right corner) with a sticker identifying the unit model number (E6640A) and serial number. Inside each envelope will be from two to five CoCs: one for the reference module, and one for each of the TRX modules installed in the test set. This package constitutes your test set’s calibration data.

You may choose to physically attach calibration stickers to your E6640A test set (recommended), or, as many customers do, you may choose to use the modules’ electronic calibration information to identify the calibration status of any module at any time. The use of electronic calibration information is of benefit to those customers that may want to move modules from one instrument to another: the calibration date always follows the module.

To summarize: calibration of the E6640A is not done at the instrument level, but an E6640A is fully calibrated when all of the modules (Reference module and TRX modules) are calibrated. At initial shipment, this information is provided in the yellow envelope supplied with each unit.
Desktop Icons

Five desktop icons provide access to utilities which support the E6640A’s measurement firmware.

Figure 3-6 Caption

- Configure Applications MultiTouch
- Launch XSA Applications MultiTouch UI
- TRX Configurator
- Configure Applications
- Launch XSA Applications
TRX Configurator

The TRX Configurator tool shows which of the four possible TRXs are installed in the PXIe rack, and identifies them by SCPI address. At a minimum, TRX1 must be installed, and cannot be disabled using this tool. However, the other TRXs, if installed, can be enabled or disabled using the checkbox in the right column.

**Figure 3-7 The TRX Configurator**

<table>
<thead>
<tr>
<th>TRX #</th>
<th>HW Installed</th>
<th>TRX SCPI Address</th>
<th>xSA Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRX 1</td>
<td>Installed</td>
<td>TCP/IP: K-E6640A-00099::inst0::INSTR</td>
<td>✅ Enable?</td>
</tr>
<tr>
<td>TRX 2</td>
<td>Installed</td>
<td>TCP/IP: K-E6640A-00099::inst1::INSTR</td>
<td>✅ Enable?</td>
</tr>
<tr>
<td>TRX 3</td>
<td>Installed</td>
<td>TCP/IP: K-E6640A-00099::inst2::INSTR</td>
<td>✅ Enable?</td>
</tr>
<tr>
<td>TRX 4</td>
<td>Not Installed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **UpdateFPGA** button is used when installing a new TRX into an E6640A which was purchased without it, to ensure software compatibility.
Launch XSA

On bootup, the E6640A opens an XSA application window for each TRX which is (1) installed and (2) enabled in the TRX Configurator described above.

Figure 3-8 Launching XSA applications

If you have closed any of the XSA application windows, you can reopen them without rebooting, by clicking the Launch XSA icon. This will only open a window for a given TRX if it is enabled in the TRX Configurator.
Configure XSA Applications

Click the Configure Applications icon to launch this utility, which allows you to specify which of the E6640A’s measurement applications will be preloaded into memory at startup. Preloading the most frequently-used applications is a convenience (however, selecting fewer of them for preload shortens the startup time and uses less memory).

Figure 3-9 Configure XSA Applications

A selector at the lower left of the window allows you specify which application will be running when the E6640A starts up.
Minimized Windows

Minimized windows can be reopened by finding the icon representing them in the Windows taskbar.

Figure 3-10 Reopening minimized windows
Port Configuration

Any of the TRXs four RF ports can be configured as an input port (accepting a signal to be analyzed) or as an output port (providing an RF stimulus).

If the test set was purchased with Option 4FD, the TRX model used is M9433A, and ports RFIO 1 through RFIO 4 connect to the source and analyzer through a splitter/combiner rather than a switch; therefore, they can be used in full-duplex mode (that is, with a given port used for both input and output simultaneously). These ports can also be configured as input-only, or output-only. For more information on this option, see “Option 4FD: Full Duplex Port Setup” on page 69 and “Option 4FD: Separate Input and Output Port Setup” on page 70.

If the test set was purchased without Option 4FD, the TRX model used is M9432A. In this model, only Ports RFIO 1 and RFIO 2 connect to the source and analyzer through a splitter/combiner (and can therefore be used in full-duplex mode). Ports RF3 I/O and RF4 I/O connect to the source and analyzer through a switch (each can serve as an input or an output, but can’t do both at once).

NOTE: The 5G NR test application is currently not supported on the M9432A TRX.
Full Duplex Port Setup (RFIO 1 and RFIO 2)

Ports RFIO 1 and RFIO 2 on the M9432A TRX (Option 2FD) connect to a splitter/combiner, and can therefore be used in full duplex mode.

To use the RFIO 1 port as the input and output, set up the RF Input using this menu setting or its equivalent command:

**Input/Output > RF Input > RF Input Port > RFIO 1**

Command:
:`FEED:RF:PORT RFIO1`

Then set up the RF Output using this menu setting or its equivalent command:

**Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 1**

Command:
:`FEED:RF:PORT:OUTP RFIO1`
To use the RFIO 2 port as the input and output, set up the RF Input using this menu setting or its equivalent command:

**Input/Output > RF Input > RF Input Port > RFIO 2**

Command:

`:FEED:RF:PORT RFIO2`

Then set up the RF Output using this menu setting or its equivalent command:

**Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 2**

Command:

`:FEED:RF:PORT:OUTP RFIO2`
Separate Input and Output Port Setup (RF3 I/O and RF4 I/O)

Ports RF3 I/O and RF4 I/O on the M9432A TRX (Option 2FD) connect to a switch rather than a splitter/combiner, which means that one of these ports must be used as either an input or an output, not both, at any given time.

Because there is less RF path loss when a switch is used, these ports are preferred in situations where it is important to maximize RF power to the analyzer or from the source.

To define RF3 I/O as an input and RF4 I/O as an output, use the following steps.

Define RF3 I/O as an input, using this menu setting or its equivalent command:

\[ \text{Input/Output} \rightarrow \text{More} \rightarrow \text{RF Output & Test Set Config} \rightarrow \text{Half Duplex Config} \rightarrow \text{RF Input Port} \rightarrow \text{RF3 I/O} \]

Command:
\[ \text{:HDUPlex:PORT:INPut RFIO3} \]

Define RF4 I/O as an output, using this menu setting or its equivalent command:

\[ \text{Input/Output} \rightarrow \text{More} \rightarrow \text{RF Output & Test Set Config} \rightarrow \text{Half Duplex Config} \rightarrow \text{RF Output Port} \rightarrow \text{RF3 I/O} \]

Command:
\[ \text{[:SENSe]:HDUPlex:PORT:OUTPut RFIO4} \]

**NOTE** This does not complete the port setup; two more settings are required!
XSA Interface
Port Configuration

Set up the RF Input using this menu setting or its equivalent command:
**Input/Output > RF Input > RF Input Port > RF Input**

Command:
`:FEED:RF:PORT RFIN`

Set up the RF Output using this menu setting or its equivalent command:
**Input/Output > More > RF Output & Test Set Config > RF Output Port > RF Output**

Command:
`:FEED:RF:PORT:OUTP RFO`
To define RF4 I|O as an input and RF3 I|O as an output, use the following steps.

Define RF4 I|O as an input, using this menu setting or its equivalent command:

```
Input/Output > More > RF Output & Test Set Config > Half Duplex Config > RF Input Port > RF4 I|O
```

Command:

```
:HDUPlex:PORT:INPut RFIO4
```

Define RF3 I|O as an output, using this menu setting or its equivalent command:

```
Input/Output > More > RF Output & Test Set Config > Half Duplex Config > RF Output Port > RF3 I|O
```

Command:

```
[:SENSe]:HDUPlex:PORT:OUTPut RFIO3
```

NOTE: This does not complete the port setup; two more settings are required!
Set up the RF Input using this menu setting or its equivalent command:

**Input/Output > RF Input > RF Input Port > RF Input**

**Command:**

:FEED:RF:PORT RFIN

Set up the RF Output using this menu setting or its equivalent command:

**Input/Output > More > RF Output & Test Set Config > RF Output Port > RF Output**

**Command:**

:FEED:RF:PORT:OUTP RFO
Separate Input and Output Port Setup (RFIO 1 and RFIO 2)

Although Ports RFIO 1 and RFIO 2 on the M9432A TRX (Option 2FD) are designed to operate as full-duplex ports, they can function as separate inputs and outputs.

To use the RFIO 1 port as the input and the RFIO 2 port as the output, set up the RF Input using this menu setting or its equivalent command:

**Input/Output > RF Input > RF Input Port > RFIO 1**

Command:

```
:FEED:RF:PORT RFIO1
```

Then set up the RF Output using this menu setting or its equivalent command:

**Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 2**

Command:

```
:FEED:RF:PORT:OUTP RFIO2
```
Figure 3-16 RFIO 2 on M9432A used as input, RFIO 1 as output

To use the RFIO 1 port as the input and the RFIO 2 port as the output, set up the RF Input using this menu setting or its equivalent command:

**Input/Output > RF Input > RF Input Port > RFIO 2**

**Command:**

`:FEED:RF:PORT RFIO2`

Then set up the RF Output using this menu setting or its equivalent command:

**Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 1**

**Command:**

`:FEED:RF:PORT:OUTP RFIO1`
Option 4FD: Full Duplex Port Setup

If the test set was purchased with Option 4FD, the M9433A TRX is used. Each of the IO ports connects to a splitter/combiner rather than a switch, and it can be used in full duplex mode, as a simultaneous input and output. In the example illustrated below, the RFIO 2 port is used in this way. (Other ports could be selected simply by substituting different port names in the instructions provided below.)

Figure 3-17 RFIO 2 on M9433A used in full duplex mode

To use the RFIO 2 port as the input and output, set up the RF Input using this menu setting or its equivalent command:

Input/Output > RF Input > RF Input Port > RFIO 2

Command:
:FEED:RF:PORT RFIO2

Then set up the RF Output using this menu setting or its equivalent command:

Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 2

Command:
:FEED:RF:PORT:OUTP RFIO2
Option 4FD: Separate Input and Output Port Setup

Although, with Option 4FD, all of the RFIO ports are designed to operate as full-duplex ports, they can function as separate inputs and outputs. In this example, the RFIO 2 port is used as an input, and the RFIO 3 port as an output. (Other port combinations could be selected simply by substituting different port names in the instructions provided below.)

**Figure 3-18** RFIO 2 on M9433A used as input, RFIO 3 as output

To use the RFIO 2 port as the input and the RFIO 3 port as the output, set up the RF Input using this menu setting or its equivalent command:

**Input/Output > RF Input > RF Input Port > RFIO 2**

Command:

`:FEED:RF:PORT RFIO2`

Then set up RFIO 3 as the RF Output, using this menu setting or its equivalent command:

**Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 3**

Command:

`:FEED:RF:PORT:OUTP RFIO3`
LAN Address Configuration

The E6640A supports both dynamic and static assignment of its IP address, using ports LAN 1 and LAN 2 respectively.

The LAN 1 port is designed for dynamic IP addressing, using the Dynamic Host Configuration Protocol. If the your site network supports DHCP, the E6640A will be assigned an IP address automatically when it is connected to the LAN. Once the address is assigned, it is listed, along with the computer name, under System > Show > System. The address or computer name can be used to find the test set on the LAN. However, to see the System > Show > System screen and find this information, it is necessary either to connect a monitor to the front panel monitor port, or else to use the LAN 2 port to connect test set to a PC directly.

Figure 3-19 Checking the LAN address

Using the LAN 1 port to connect the test set directly to the public LAN is potentially insecure, because the test set does not provide anti-virus protection. Connecting the test set to the public LAN by way of a PC with antivirus protection is the preferred solution.

The LAN 2 port is designed to use a private static IP address, 192.168.1.2 (changing this address is possible but not recommended). This port can be used for direct connection to a PC.

To find the test set on the LAN, you will need to know its IP address or computer name. If you cannot easily obtain a monitor view of System > Show > System, you can determine the computer name using the instrument serial number. The computer name is in the format K-E6640A-nnnnn, ending in the last five digits of the serial number.
Switched MIMO

For WLAN modulation accuracy measurements, a form of MIMO measurement can be made with a single TRX, using a time-division multiplexing process. The same source/analyzer pair within the TRX switches between the antenna ports of the Device Under Test.

In contrast to true MIMO functionality, which is available in WLAN mode but not in Sequence Analyzer mode, the switched MIMO feature is a WLAN measurement which is available only in Sequence Analyzer mode.

Constraints on Radio Standards

Only certain radio standards support MIMO. Under Mode Setup > Radio Std, select 802.11n or 802.11ac.

MIMO Port Configuration

For 2x2 MIMO, the RFIO 1 port (a full-duplex port) captures the data stream from the first antenna port of the DUT. The other full-duplex port, RFIO 2, captures the data stream from the second antenna port of the DUT.

Figure 3-20 2X2 switched MIMO connections
For 3x3 MIMO, the RFIO 1 port (a full-duplex port) captures the data stream from the first antenna port of the DUT. The other full-duplex port, RFIO 2, captures the data stream from the second antenna port of the DUT. One of the half-duplex ports, RF3 I/O or RF4 I/O, captures the data stream from the third antenna port of the DUT.

![3X3 switched MIMO connections](image)

Source Sync Control

Switched MIMO is a measurement process only; it is not necessary to use Source Sync Control (required for true MIMO) in the case of switched MIMO.

RF Input Port Mode

The RF Input Port Mode must be set to List, so that the sequence can change the input port path from one acquisition to the next. In the Meas Setup > RF Input Port Mode menu, select List. The equivalent SCPI commands is:

```
[:SENSe]:LSEQuencer:PORT:INPut:MODE LIST
```

Half Duplex RF Input

In the case of 3x3 switched MIMO, one of the half-duplex ports (RF3 I/O or RF4 I/O) must be designated as an RF input port for the third input. In the Input/Output > RF Output & Test Set Config > Half Duplex Config > RF Input menu, select RFIO3 or RFIO4, so that the RF3 I/O port or the RF4 I/O port is defined as the input port. The equivalent SCPI command is:

```
[:SENSe]:HDUPlex:PORT:INPut RFIO3|RFIO4
```
Acquisition Triggers

Each of the acquisitions which make up a sequence used for switched MIMO testing needs to have the same trigger settings as the others.

Acquisition Integration

For 2x2 switched MIMO in Sequence Analyzer mode, two separate acquisitions are used for the two separate ports, and must be integrated. Set up acquisition integration as follows: in the **Meas Setup > Acquisition Setup > Acquisition Integration** menu, select **Primary** for the first acquisition and **Switch MIMO** for the second. The equivalent SCPI commands are:

```
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration PRIMary
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration SMIMo
```

For 3x3 switched MIMO in Sequence Analyzer mode, three separate acquisitions are used for the three separate ports, and must be integrated. Set up acquisition integration as follows: in the **Meas Setup > Acquisition Setup > Acquisition Integration** menu, select **Primary** for the first acquisition and **Switch MIMO** for the second and third. The equivalent SCPI commands are:

```
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration PRIMary
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration SMIMo
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration SMIMo
```

The integration parameter can also be set within the complex command which is used to set the Acquisition RF Input Port (see “Acquisition RF Input Port” on page 75); the integration parameter is the one which comes immediately before the Acquisition RF Input Port parameter.
Acquisition RF Input Port

An RF input path must be selected for each acquisition. In the Meas Setup > Acquisition Setup > Acquisition RF Input Port menu, select RFIO1, RFIO2, or RF Input, as needed for each acquisition. The RF Input selection, which is used for the third port in 3x3 switched MIMO, means that whichever of the half-duplex ports (RF3 I/O or RF4 I/O) has been designated as the RF input is used (see “Half Duplex RF Input” on page 73). In SCPI, the acquisition RF input port is controlled by the last parameter in the complex command which configures the acquisition (the values for the relevant parameter are italicized here):

```
[:SENSe]:LSEQuencer:ACQuire[1]|2|...|4..512:SETup
NONE | GSM | EDGE | WCDMA | CDMA2K | CDMA1XEV | LTE | LTETDD |
TDSCDMA | BTooth | WLAN,
NONE | PGSMS | EGSM | RGSMS | DC8100 | PC51900 | TG5810 | GSM450 |
GSM480 | GSM850 | GSM700 | BANDI | BANDII | BANDIII | BANDIV |
BANDV | BANDVI | BANDVII | BANDVIII | BANDIX | BANDX | BANDXI |
BANDXII | BANDXIII | BANDXIV | USCELL | USPCS | JAPAN | KOREAN |
NMT | IMT2K | UPPER | SECOND | PM400 | PAMR800 | IMTEXT |
PCS109G | AWS | US2DOT5G | PUBLIC | LOWER | BAND1 | BAND2 | BAND3 |
| BAND4 | BAND5 | BAND6 | BAND7 | BAND8 | BAND9 | BAND10 | BAND11 |
BAND12 | BAND13 | BAND14 | BAND17 | BAND18 | BAND19 | BAND20 |
BAND21 | BAND24 | BAND25 | BAND26 | BAND27 | BAND28 | BAND31 |
BAND33 | BAND34 | BAND35 | BAND36 | BAND37 | BAND38 | BAND39 |
BAND40 | BAND41 | BAND42 | BAND43 | BAND44 | BANDA | BANDB | BANDC |
| BANDD | BANDE | BANDF, |
BTS | MS,
<real>, <integer>, <ampl>,
LOW | ZERO | HIGH,
<time>, <time>,
IMMediate | VIDeo | Video2 | INTernal | EXT1 | EXT2,
<amptd>, <time>,
NONE | INT/,
<relative ampl>,
OFF | RFIO0 | RFIO1 | RFIO2 | RFIO3 | RFIO4 | RFIO5 | RFIO6 |
RFIO7, |
ON | OFF,
NORMal1 | PRIMary | LOWer | UPPer | RANGE | SMIMO, |
RFIO1 | RFIO2 | RFIN | RFIO3 | RFIO4
```

In the Acquisition RF Input Port parameter (italicized above), the values RFIO3 and RFIO4 apply only if the test set has Option 4FD. The parameter immediately preceding that one is the Acquisition Integration parameter, and can be set to PRIMary or SMIMO as needed (see “Acquisition Integration” on page 74).
### Switched MIMO Modulation Accuracy measurement SCPI commands

The following commands are used to set up the MIMO Modulation Accuracy ("EVM MIMO") measurement.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:FERRor &lt;real&gt;</td>
<td>Freq Error</td>
<td>Sets a frequency error limit</td>
</tr>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:CLKerror &lt;real&gt;</td>
<td>Clock Error</td>
<td>Sets a clock error limit</td>
</tr>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:CFLeakage &lt;rel_ampl&gt;</td>
<td>Center Freq Leakage</td>
<td>Sets Center Freq Leakage limit</td>
</tr>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS:QA64:R1B2 &lt;rel_ampl&gt;</td>
<td>64QAM–2/3 RMS EVM</td>
<td>Sets 64QAM coding rate 2/3 RMS EVM limit</td>
</tr>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS:QA64:R5B6 &lt;rel_ampl&gt;</td>
<td>64QAM–5/6 RMS EVM</td>
<td>Sets 64QAM coding rate 5/6 RMS EVM limit</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
<td>Notes</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:EQUalizer:TMODE SEQuence</td>
<td>SDATa</td>
<td>Equalizer Training</td>
</tr>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:PILot:TRACT:AMPLitude OFF</td>
<td>ON</td>
<td>0</td>
</tr>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:PILot:TRACT:PHASE OFF</td>
<td>ON</td>
<td>0</td>
</tr>
<tr>
<td>:CALCulate:LSEQuencer:WLAN:EVMMimo:PILot:TRACT:MODE POSTeq</td>
<td>PREeq</td>
<td>Pilot Tracking Mode</td>
</tr>
<tr>
<td>[:SENSe]:LSEQuencer:WLAN:EVMMimo:MTYPE DMAP</td>
<td>FOURIer</td>
<td>Matrix Type</td>
</tr>
</tbody>
</table>
Switched MIMO Results

The results available for a WLAN MIMO Modulation Accuracy measurement are as follows (the results for Stream 3 are returned as -1.0 (not tested) in the case of 2x2 MIMO):

<table>
<thead>
<tr>
<th>Index</th>
<th>Result Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Overall Pass/Fail Result (0 = Pass, 1 = Fail, -1 = Not tested)</td>
</tr>
<tr>
<td>1</td>
<td>Stream 1 RMS EVM pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)</td>
</tr>
<tr>
<td>2</td>
<td>Stream 1 RMS EVM (dB)</td>
</tr>
<tr>
<td>3</td>
<td>Stream 1 Peak EVM (dB)</td>
</tr>
<tr>
<td>4</td>
<td>Stream 1 Pilot EVM (dB)</td>
</tr>
<tr>
<td>5</td>
<td>Stream 1 Data EVM (dB)</td>
</tr>
<tr>
<td>6</td>
<td>Stream 1 Chips Peak EVM (%)</td>
</tr>
<tr>
<td>7-12</td>
<td>7-12: Stream 2 (as in Index 1-6 above). 13-18: Stream 3 (as in Index 1-6 above)</td>
</tr>
<tr>
<td>19-24</td>
<td>Reserved</td>
</tr>
<tr>
<td>25</td>
<td>Channel 1 RMS EVM pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)</td>
</tr>
<tr>
<td>26</td>
<td>Channel 1 Frequency Error pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)</td>
</tr>
<tr>
<td>27</td>
<td>Channel 1 Symbol Clock Error pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)</td>
</tr>
<tr>
<td>28</td>
<td>Channel 1 IQ Offset pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)</td>
</tr>
<tr>
<td>29</td>
<td>Channel 1 RMS EVM (dB)</td>
</tr>
<tr>
<td>30</td>
<td>Channel 1 Peak EVM (dB)</td>
</tr>
<tr>
<td>31</td>
<td>Channel 1 Pilot EVM (dB)</td>
</tr>
<tr>
<td>32</td>
<td>Channel 1 Data EVM (dB)</td>
</tr>
<tr>
<td>33</td>
<td>Channel 1 Frequency Error (Hz)</td>
</tr>
<tr>
<td>34</td>
<td>Channel 1 Symbol Clock Error (ppm)</td>
</tr>
<tr>
<td>35</td>
<td>Channel 1 IQ Gain Imbalance (dB)</td>
</tr>
<tr>
<td>36</td>
<td>Channel 1 IQ Offset (dB)</td>
</tr>
<tr>
<td>37</td>
<td>Channel 1 IQ Quadrature Error (deg)</td>
</tr>
<tr>
<td>38</td>
<td>Channel 1 IQ Timing Skew (pps)</td>
</tr>
<tr>
<td>39</td>
<td>Channel 1 Cross Power (dB)</td>
</tr>
<tr>
<td>40</td>
<td>Channel 1 Sync Corr</td>
</tr>
<tr>
<td>41-56</td>
<td>41-56: Channel 2 (as in Index 25-40 above). 57-72: Channel 3 (as in Index 25-40 above)</td>
</tr>
<tr>
<td>73-88</td>
<td>Reserved</td>
</tr>
</tbody>
</table>
True MIMO

In WLAN mode, True MIMO (simultaneous rather than switched MIMO) is supported for the MIMO Modulation Analysis measurement. (This functionality is not available in Sequence Analyzer mode.) Setting up this type of measurement requires configuration of two separate TRXs.

For MIMO Modulation Analysis, two or more measurement data streams are captured simultaneously, by two or more separate TRXs in the EXM test set. In the EXM, the TRXs share a common frequency reference. They also share a common IP address, but have separate socket numbers. In MIMO testing, a single TRX is designated the primary, and it controls the other TRX or TRXs used.

TRX Configurations

Here is an example of 2x2 MIMO:

Figure 3-22  2X2 true MIMO connections

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis measurement, and is also configured to control TRX 2, which collects the second data stream. The primary TRX controls the measurement settings for the secondary TRX, and also processes the measurement data collected by the secondary. (The display window for the secondary will display a mostly-blank screen, with a message indicating that it is in use by the primary.)
Here is an example of 3x3 MIMO:

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis measurement, and is also configured to control TRX 2 and 3, which collect the second and third data streams.
Here is an example of 4x4 MIMO:

Figure 3-24 4X4 true MIMO connections

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis measurement, and is also configured to control TRX 2 to 4, which collect the second, third, and fourth data streams.
Source Settings for MIMO

Unlike measurement settings, which are made only to the primary TRX and applied to the others, source settings can be made separately for each TRX. However, it is possible to make certain source settings to other TRXs by making them to the primary TRX. Also, when the measurement is run, the primary TRX communicates with the other TRXs to ensure that they begin playing ARB files simultaneously.

To run the sources synchronously:

1. If there are any source settings which you don’t plan to make by way of the primary TRX, begin by making them individually on each TRX which will be used in the MIMO test.

2. Select the source synchronization type on the primary TRX which will be used in the MIMO test:
   - For 2x2 MIMO, set up source synchronization as follows: in the Source > Source Sync Control menu, select 2x2. Do this for both TRXs. The equivalent SCPI command is: :SOURce:SYNC:CONFig TWO
   - For 3x3 MIMO, set up source synchronization as follows: in the Source > Source Sync Control menu, select 3x3. Do this for all three TRXs. The equivalent SCPI command is: :SOURce:SYNC:CONFig THRee
   - For 4x4 MIMO, set up source synchronization as follows: in the Source > Source Sync Control menu, select 4x4. Do this for all four TRXs. The equivalent SCPI command is: :SOURce:SYNC:CONFig FOUR
   - For 2x2 + 2x2 MIMO, set up source synchronization as follows: in the Source > Source Sync Control menu, select 2x2+2x2. Do this for all four TRXs. The equivalent SCPI command is: :SOURce:SYNC:CONFig DTWO
   - For 1x1 + 1x1 MIMO, set up source synchronization as follows: in the Source > Source Sync Control menu, select 1x1+1x1. Do this for all four TRXs. The equivalent SCPI command is: :SOURce:SYNC:CONFig DONE

3. In the window for the primary TRX, go to the Source > Source Sync Control > Sync Settings Setup menu and press Sync Settings [On]. With this feature enabled, certain settings for the primary TRX source (frequency, amplitude, waveform, trigger source, trigger type, and RF output) are also applied to the other TRX sources. The equivalent SCPI command is: :SOURce:SYNC:SETT:ENAB ON

4. For 1x1 + 1x1 MIMO or 2x2 + 2x2 MIMO, go to the Source > Source Sync Control > Sync Settings Setup > Segment 2 Setup menu and press Sync Segment 2 [On]. With this feature enabled, certain non-frequency settings
for the primary TRX source (amplitude, waveform, trigger source, trigger type, and RF output) are also applied to the second of two “2x2 + 2x2” or “1x1 + 1x1” pairs of TRXs. The equivalent SCPI command is:
:SOUR:SYNC:SETT:SEGM2:ENAB ON

5. For 1x1 + 1x1 MIMO or 2x2 + 2x2 MIMO, go to the Source > Source Sync Control > Sync Settings Setup > Segment 2 Setup menu and press Segment 2 Frequency. With this feature enabled, a specified frequency setting can be applied to the second of two “2x2 + 2x2” or “1x1 + 1x1” pairs of TRXs. This is necessary if the desired frequency is anything other than the default value of 1 GHz. An example of the equivalent SCPI command is:
:SOUR:SYNC:SETT:SEGM2:FREQ 2.00 GHz

6. In the window for the primary TRX, activate synchronization in the Source > Source Sync Control menu by pressing Sync Start. At this point, the other TRX sources are synchronized to the primary and will play their arb files simultaneously with it. The equivalent SCPI command is:
:SOUR:SYNC:START

You can stop synchronization in the Source > Source Sync Control menu by pressing Sync Stop. The equivalent SCPI command is:
:SOURce:SYNC:STOP

**NOTE**

When **Sync Settings** is enabled, the naming of waveform files used by the sources must be coordinated; see “Constraints on Waveform File Names” on page 84.
Constraints on Waveform File Names

When **Sync Settings** is enabled, as described in the previous procedure, it is necessary to follow a convention for naming the waveform files used by the TRXs, so that the file associated with each TRX is distinguished by a TRX-specific suffix. The table below lists the suffixes for each MIMO configuration. Note that the convention for the 4X4 configuration is not the same as the convention for a pair of 2X2 configurations.

<table>
<thead>
<tr>
<th>MIMO Configuration</th>
<th>TRX Numbers</th>
<th>Equivalent Waveform File Names (“.xxx” can be .wfm, .bin, or .seq)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2x2</td>
<td>TRX 1 or TRX3</td>
<td>&lt;name&gt;0.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 2 or TRX4</td>
<td>&lt;name&gt;1.xxx</td>
</tr>
<tr>
<td>3x3</td>
<td>TRX 1</td>
<td>&lt;name&gt;0.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 2</td>
<td>&lt;name&gt;1.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 3</td>
<td>&lt;name&gt;2.xxx</td>
</tr>
<tr>
<td>4x4</td>
<td>TRX 1</td>
<td>&lt;name&gt;0.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 2</td>
<td>&lt;name&gt;1.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 3</td>
<td>&lt;name&gt;2.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 4</td>
<td>&lt;name&gt;3.xxx</td>
</tr>
<tr>
<td>2x2 + 2x2</td>
<td>TRX 1</td>
<td>&lt;name&gt;0_0.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 2</td>
<td>&lt;name&gt;0_1.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 3</td>
<td>&lt;name&gt;1_0.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX 4</td>
<td>&lt;name&gt;1_1.xxx</td>
</tr>
<tr>
<td>1x1 + 1x1</td>
<td>TRX1 or TRX3</td>
<td>&lt;name&gt;0_0.xxx</td>
</tr>
<tr>
<td></td>
<td>TRX2 or TRX4</td>
<td>&lt;name&gt;1_0.xxx</td>
</tr>
</tbody>
</table>

Constraints on TRX Selection

Not every TRX can be designated the primary for purposes of MIMO testing. The permitted configurations are:

<table>
<thead>
<tr>
<th>MIMO Configuration</th>
<th>Primary TRX</th>
<th>Secondary TRXs</th>
</tr>
</thead>
<tbody>
<tr>
<td>2x2</td>
<td>TRX 1</td>
<td>TRX 2, Socket 5125</td>
</tr>
<tr>
<td>2x2 (alternative setup)</td>
<td>TRX 3</td>
<td>TRX 4, Socket 5325</td>
</tr>
<tr>
<td>3x3</td>
<td>TRX 1</td>
<td>TRX 2, Socket 5125</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TRX 3, Socket 5225</td>
</tr>
<tr>
<td>4x4</td>
<td>TRX 1</td>
<td>TRX 2, Socket 5125</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TRX 3, Socket 5225</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TRX 4, Socket 5325</td>
</tr>
</tbody>
</table>
Constraints on Radio Standards

Only certain radio standards support MIMO. Under **Mode Setup > Radio Std**, select **802.11n** or **802.11ac**.

MIMO Type

For the MIMO Modulation Analysis measurement, go to the **Meas Setup > MIMO Type** menu and select **2x2**, **3x3**, or **4x4**. This setting determines whether the display shows two, three, or four constellation diagrams for the measurement. The equivalent SCPI command is:

```
[:SENSe]:EVMmimo:TYPE M2M2|M3M3|M4M4
```

Remote Analyzer Configuration

This feature is used to coordinate TRXs within the test set; it is named this way because its original purpose was to coordinate the test set with external equipment.

**NOTE**

The MIMO configuration that is set up here needs to match the **MIMO Type** selection, as described above. Error messages will be displayed until the two are in agreement.

1. From the primary TRX window (TRX 1 in this example), select **Mode Setup > Global Settings > Remote Analyzer Config**.
2. A list is displayed which includes any TRX which you have previously used (unless you have deleted it) and any added while in the **Add Analyzer to List** menu. However, the list may be blank, or may not include the desired TRX.
3. To add a TRX to the list, press **Add Analyzer to List**.
4. Click **IP Address**, use the numeric keys to enter an IP address for the test set, and press **Enter**. In this example, the test set's localhost address is used (for the EXM test set, the localhost address has a fixed value of 127.0.0.1).
5. Click **SCPI Socket Port**, use the numeric keys to enter the socket number of the secondary TRX, and press **Enter**. In this example socket number 5125 (TRX 2) is used.
6. Press **Add**. The secondary TRX is now displayed in the list.
7. Select the desired TRX from the displayed list (use the up and down arrow keys to move the highlighted selection to the desired TRX and then press **Select Highlighted Analyzer**).
8. The secondary TRX is now being run from the present TRX. The window for the secondary TRX displays a "This instrument is in use..." message. If you need to release it from control, go to the primary TRX and select **Mode Setup > Global Settings > Remote Analyzer Config > Release Current Analyzer**, or send to the primary the equivalent SCPI command:

```
:SYST:COMM:ANAL:REL
```

9. The equivalent SCPI command for the steps described above is as follows (modify the address string "127.0.0.1:5125" as needed):

```
:SYST:COMM:ANAL:SEL "127.0.0.1:5125"
```

**Figure 3-25**  
IP and socket port addresses
MIMO Modulation Analysis measurement SCPI commands

The following commands are used to set up the MIMO Modulation Analysis measurement.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>[:SENSe]:EVM:mimo:TYPE DMAP</td>
<td>FOURIer</td>
<td>Matrix Type</td>
</tr>
<tr>
<td>[:SENSe]:EVM:mimo:TYPE M2M2</td>
<td>M3M3</td>
<td>M4M4</td>
</tr>
<tr>
<td>[:SENSe]:EVM:mimo:RESULT:STREAM &lt;integer&gt;</td>
<td>MIMO Result Stream Index</td>
<td>Specifies the result stream by number.</td>
</tr>
<tr>
<td>[:SENSe]:EVM:mimo:RESULT:CHANNEL &lt;integer&gt;</td>
<td>MIMO Result Channel Index</td>
<td>Specifies the result channel by number.</td>
</tr>
</tbody>
</table>
MIMO Modulation Analysis Results

The results available for a WLAN MIMO Modulation Analysis measurement are as follows (the results for Stream 3 are returned as -1.0 (not tested) in the case of 2x2 MIMO):

<table>
<thead>
<tr>
<th>Index</th>
<th>Result Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Returns unprocessed I/Q trace data of Capture Interval, as a series of trace point values for Channel m. Channel index m can be set and queried through EVMM:RESult:CHAN command. The I values are listed first in each pair, using the 0 through even-indexed values. The Q values are the odd-indexed values.</td>
</tr>
<tr>
<td>1</td>
<td>Returns the comma-separated EVM results by stream. The EVM scalar results for each stream are in the following order: 1. RMS EVM Max (dB) 2. RMS EVM Avg (dB) 3. Peak EVM Max (dB) 4. Peak EVM Avg (dB) 5. Pilot EVM Max (dB) 6. Pilot EVM Avg (dB) 7. Data EVM Max (dB) 8. Data EVM Avg (dB) 9. CPE EVM Max (dB) 10. CPE EVM Avg (dB) When MIMO Type is 2x2, this result gives stream 1 EVM scalar results first, then stream 2 EVM scalar results. When MIMO Type is 3x3, stream 1, 2 and 3 EVM scalar results are provided in order. When MIMO Type is 4x4, returns 40 comma-separated EVM scalar results, provided in stream order.</td>
</tr>
<tr>
<td>2</td>
<td>Returns a value of the pass/fail (0.0 = passed, or 1.0 = failed) results determined by testing the result of RMS EVM. Only when all the stream RMS EVM Average results are passed, will this value be passed.</td>
</tr>
<tr>
<td>3</td>
<td>Returns series of floating point numbers that alternately represent I and Q pairs of the corrected measured trace for STRM m. Stream index m can be set and queried through EVMM:RESult:STReam command. The magnitude of each I and Q pair are normalized to 1.0, when the IQ Normalize is turned on. The first number is the in-phase (I) sample and the second is the quadrature-phase (Q) sample.</td>
</tr>
<tr>
<td>4</td>
<td>Returns series of floating point numbers (in dB) that represent each sample in the Stream EVM vs. Carrier trace of Capture Interval for STRM m. Stream index m can be set and queried through EVMM:RESult:STReam command.</td>
</tr>
<tr>
<td>5</td>
<td>Returns series of floating point numbers (in dB) that represent each sample in the Stream EVM vs. Symbol trace of Capture Interval for STRM m. The first number is the symbol 0 decision point. Stream index m can be set and queried through EVMM:RESult:STReam command.</td>
</tr>
<tr>
<td>6</td>
<td>Returns series of floating point numbers that represent each sample in the Channel Response for STRM m CH k. Stream index m can be set and queried through EVMM:RESult:STReam command. Channel index k can be set and queried through EVMM:RESult:CHAN command.</td>
</tr>
</tbody>
</table>
XSA Interface
True MIMO

<table>
<thead>
<tr>
<th>Index</th>
<th>Result Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Returns comma-separated EVM scalar results by channel. The EVM scalar results for each channel are in the following order:</td>
</tr>
<tr>
<td></td>
<td>1. RMS EVM Max (dB)</td>
</tr>
<tr>
<td></td>
<td>2. RMS EVM Avg (dB)</td>
</tr>
<tr>
<td></td>
<td>3. Peak EVM Max (dB)</td>
</tr>
<tr>
<td></td>
<td>4. Peak EVM Avg (dB)</td>
</tr>
<tr>
<td></td>
<td>5. Pilot EVM Max (dB)</td>
</tr>
<tr>
<td></td>
<td>6. Pilot EVM Avg (dB)</td>
</tr>
<tr>
<td></td>
<td>7. Data EVM Max (dB)</td>
</tr>
<tr>
<td></td>
<td>8. Data EVM Avg (dB)</td>
</tr>
<tr>
<td></td>
<td>9. Freq Error Max (Hz)</td>
</tr>
<tr>
<td></td>
<td>10. Freq Error Avg (Hz)</td>
</tr>
<tr>
<td></td>
<td>11. Freq Error Ppm Max (ppm)</td>
</tr>
<tr>
<td></td>
<td>12. Freq Error Ppm Avg (ppm)</td>
</tr>
<tr>
<td></td>
<td>13. Sym Clock Error Max (ppm)</td>
</tr>
<tr>
<td></td>
<td>14. Sym Click Error Avg (ppm)</td>
</tr>
<tr>
<td></td>
<td>15. IQ Gain Imb Max (dB)</td>
</tr>
<tr>
<td></td>
<td>16. IQ Gain Imb Avg (dB)</td>
</tr>
<tr>
<td></td>
<td>17. IQ Offset Max (dB)</td>
</tr>
<tr>
<td></td>
<td>18. IQ Offset Avg (dB)</td>
</tr>
<tr>
<td></td>
<td>19. IQ Quad Error Max (degree)</td>
</tr>
<tr>
<td></td>
<td>20. IQ Quad Error Avg (degree)</td>
</tr>
<tr>
<td></td>
<td>21. IQ Timing Skew Max (s)</td>
</tr>
<tr>
<td></td>
<td>22. IQ Timing Skew Avg (s)</td>
</tr>
<tr>
<td></td>
<td>23. Cross Pwr Max (dB)</td>
</tr>
<tr>
<td></td>
<td>24. Cross Pwr Avg (dB)</td>
</tr>
<tr>
<td></td>
<td>25. Sync Corr Max</td>
</tr>
<tr>
<td></td>
<td>26. Sync Corr Avg</td>
</tr>
<tr>
<td></td>
<td>27. Avg Burst Power Max (dBm)</td>
</tr>
<tr>
<td></td>
<td>28. Avg Burst Power Avg (dBm)</td>
</tr>
<tr>
<td></td>
<td>29. Peak Burst Power Max (dBm)</td>
</tr>
<tr>
<td></td>
<td>30. Peak Burst Power Avg (dBm)</td>
</tr>
</tbody>
</table>

When MIMO Type is 2x2, 60 comma-separated scalar results are returned; When MIMO Type is 3x3, 90 comma-separated scalar results are returned; When MIMO Type is 4x4, 120 comma-separated scalar results are returned.

8 | Return the Channel Matrix results.

9 | Return the decode bits of HT-SIG Signal.

10 | Returns series of floating point numbers (in dB) that represent each sample in the Equalizer Impulse Response for STRM m CH k. Stream index m can be set and queried through EVMM:RESult:STReam command. Channel index k can be set and queried through EVMM:RESult:CHAN command.

11 | Returns comma-separated floating point numbers of spectral flatness trace for STRM m CH k. Stream index m can be set and queried through EVMM:RESult:STReam command. Channel index k can be set and queried through EVMM:RESult:CHAN command.

12 | Returns Data Rate (in Mbps) for MIMO input signals.
<table>
<thead>
<tr>
<th>Index</th>
<th>Result Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>13</td>
<td>Returns the FFT SEM trace consisting of 5001 points if SEM is activated for Ch k. Chan index k can be set and queried through through EVMM:RESult:CHAN command.</td>
</tr>
<tr>
<td>14</td>
<td>Returns the SEM failed information consisting of (2(DeltaFreq,DeltaAmplitude) x 6(OffsetA Lower, OffsetA Upper, OffsetB Lower, OffsetB Upper, Offset C Lower, Offset C Upper)=12 values in upper and lower bands of three offsets for Ch k. Chan index k can be set and queried through through EVMM:RESult:CHAN command.</td>
</tr>
</tbody>
</table>

**NOTE**

When MIMO Type is 2X2 and Radio Standard is 80+80 MHz, all these measurement results are only for one segment. Use SCPI command EVMM:RESult:SEGment to specify that these contents are the first segment results or the second segment results.
XSA Interface
Tx Beam Forming

Tx Beam Forming

If license V9077B-KFP is installed, Tx Beam-Forming results are available from the Modulation Analysis measurement in WLAN mode.

Tx Beam Forming Commands

Two commands are added for Tx Beam Forming, as described in the table below. The first command sets up the measurement’s EVM demodulation algorithm to provide EVM results or Tx Beam Forming Results. The second command is used to specify the channel count of the measured MIMO signal.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
</table>
| [:SENSe]:EVM:BFORming:MTYPe EVM|TXBFcal | This command is only available when license V9077B-KFP is installed; otherwise, “-113, Undefined Header” error will be reported.

This parameter takes effect when the Radio Std is 802.11n(20MHz), 802.11n (40MHz), 802.11ac (20MHz), 802.11ac (40MHz), 802.11ac (80MHz) and 802.11ac (160MHz)

When EVM is selected, the result index 1~20 are calculated with meaningful values for EVM measurement, and result 21 and 22 results are -999.0;

When TXBFcal is selected, the result index 1~20 values will not be calculated; Instead, result 21 and 22 are calculated and returned.

[:SENSe]:EVM:ACChannel <integer> <real> | For Radio Std 802.11n (20MHz) and 802.11n (40MHz), Tx Beam Forming with channel count <=4 is supported;

For Radio Std 802.11ac (20MHz), 802.11ac (40MHz), 802.11ac (80MHz), and 802.11ac (160MHz), Tx Beam Forming with channel count <=8 is supported.
**XSA Interface**  
**Tx Beam Forming**

**Tx Beam Forming Results**

The Tx Beam Forming results are added to the Modulation Analysis measurement results as Index 21 and Index 22, as described in the table below.

<table>
<thead>
<tr>
<th>Index</th>
<th>Result Parameter</th>
</tr>
</thead>
</table>
| 21    | Tx Beam Forming Calibrated Angle Error  
returns a series of floating point numbers (in rad) that represent the calibrated angle error vectors on channels, when  
- Radio Std is 802.11n (20 MHz), or 802.11n (40 MHz), and MIMO Tx Channel Count <= 4  
- Radio Std is 802.11ac(20MHz), 802.11ac(40MHz), 802.11ac(80MHz), or 802.11ac(160MHz), and MIMO Tx Channel Count <= 8  
- MIMO Usage Type is TXBFoming (available when license V9077B-KFP is installed)  
Otherwise, returns -999.0.  
The first channel angle vector is used as reference; the angle error vectors are listed in order of channels. For the 20MHz BW signals, each channel’s angle error vector contains 64 values; For the 40MHz BW signals, each channels angle error vector contains 128 values; For the 80MHz BW signals, each channels angle error vector contains 256 values, For 160MHz BW signals, each channels angle error vector contains 512 values. |
| 22    | Tx Beam Forming Gain  
returns gain after the calibrated angle error vector are compensated for the MIMO input signal, when  
- Radio Std is 802.11n (20 MHz), or 802.11n (40 MHz), and MIMO Tx Channel Count <= 4  
- Radio Std is 802.11ac(20MHz), 802.11ac(40MHz), 802.11ac(80MHz), or 802.11ac(160MHz), and MIMO Tx Channel Count <= 8  
- MIMO Usage Type is TXBFoming (available when license V9077B-KFP is installed)  
Otherwise, returns -999.0. |
4 XSA MultiTouch Interface

The following topics can be found in this section:

“Distinguishing the Interfaces” on page 94
“Alignments” on page 95
“TRX Selection” on page 97
“E6640A Calibration Status” on page 99
“Desktop Icons” on page 101
“Port Configuration” on page 106
“LAN Address Configuration” on page 109
Distinguishing the Interfaces

Most test applications in the E6640A run in the XSA interface (illustrated on the left below); the 5G NR application runs in the newer XSA MultiTouch UI (illustrated on the right below). The most visible difference between the interfaces is in the menus in the rightmost column of the display.

Figure 4-1  XSA Interface and XSA MultiTouch UI

The XSA interface relies on a combination of submenus and a Virtual Front Panel popup window. The XSA MultiTouch UI operates primarily by opening temporary configuration screens for each settable parameter.

This chapter is devoted to the XSA MultiTouch UI; see Chapter 3, “XSA Interface”, on page 47 for information on the other interface.
Alignments

Alignments are internal calibration adjustments which each TRX module must make to ensure that internal signal levels are properly maintained. To avoid interruptions, the alignments are not run automatically, either at startup or afterward; you must run them explicitly.

“All” Alignment (daily use)

This alignment of the source and analyzer in the TRX is sufficient to maintain specified performance, provided that (1) the TRX’s internal temperature has not drifted more than 5 degrees C since the previous alignment, (2) no more than 8 hours have elapsed since the previous “All” alignment, and (3) no more than 1 week has elapsed since the previous weekly alignment (see below). The “All” alignment typically takes less than 5 minutes to run.

The TRX’s internal temperature can be checked by sending the SCPI query :CAL:TEMP:CURR?

To run the alignment, select System Settings > Alignments > Align Now > Align Now All, or send the SCPI command :CAL:ALL.

NOTE

The alignment process requires a 45-minute preliminary warm-up period, after applying power or after restarting the XSA application (when the application is not running, power is not applied to the TRXs; therefore an application shutdown has the same effect on alignment as a power shutdown).
Weekly alignment procedure

A more thorough alignment of the source and analyzer in the TRX is required on a weekly basis. This procedure is similar to the "All" alignment described above, but it also performs additional alignment functions related to slow-drifting parameters which do not change significantly over time periods shorter than a week.

1. Select System Settings > Alignments > Align Now > Align All But RF, or send the SCPI commands:
   :CAL:NRF
   *WAI

2. Select System Settings > Alignments > Align Now > Align Source, or send the SCPI commands:
   :CAL:SOUR
   *WAI

3. Select System Settings > Alignments > Align Now > Align Now IF, or send the SCPI commands:
   :CAL:IF
   *WAI

Figure 4-2 Alignments menus

This alignment process also requires the same 45-minute preliminary warm-up period described under “All” Alignment (daily use) on page 95.
TRX Selection

On the monitor or remote desktop view of the test set, each TRX is represented by a separate XSA window. You can identify which TRX a window controls by looking for the identifier (TRX1 through TRX4 for a fully loaded system) at the top left corner of the window. (The TRXs are placed in numerical order in the PXIe chassis, beginning with TRX1 on the left.)

![Identifying application windows for different TRXs](image)

Although the test set as a whole is assigned only one IP address for the entire PXIe chassis, the individual TRXs within the chassis can be differentiated in network communication with the test set. The means of identifying a TRX depends upon the connection method, as outlined below.

Using HiSLIP

**NOTE**

HiSLIP (High-Speed LAN Instrument Protocol) is the recommended interface for connection to the E6640A, because of its superior performance characteristics.

Use hislip0 through hislip3:

- **TRX1:**
  
  TCP/IP0::<IP Address>::hislip0::INSTR

- **TRX2:**
  
  TCP/IP0::<IP Address>::hislip1::INSTR

- **TRX3:**
  
  TCP/IP0::<IP Address>::hislip2::INSTR

- **TRX4:**
  
  TCP/IP0::<IP Address>::hislip3::INSTR
Using Socket Ports
Use sockets 5025, 5125, 5225, and 5325:

Using VXI-11/SICL
Use inst0 through inst3:
- TRX1:
  TCPIP0::<IP Address>::inst0::INSTR
- TRX2:
  TCPIP0::<IP Address>::inst1::INSTR
- TRX3:
  TCPIP0::<IP Address>::inst2::INSTR
- TRX4:
  TCPIP0::<IP Address>::inst3::INSTR

Using Telnet Connection
Use telnet ports 5023, 5123, 5223, 5323:
- TRX1:
  5023
- TRX2:
  5123
- TRX3:
  5223
- TRX4:
  5323
E6640A Calibration Status

The E6640A EXM test set does not have a calibration certificate, because of its flexibility in configuration:

- The E6640A chassis can have 1, 2, 3, or 4 TRXs (M943xA) installed.
- Different TRXs can have different hardware configurations for frequency range and/or bandwidth.
- Additional TRXs can be added to an E6640A chassis after the initial instrument purchase. These would have different calibration due dates, and different warranty end dates, from the modules that were originally purchased with the E6640A.

There isn’t a single instrument-level calibration (or calibration due-date) that covers the E6640A as a whole and all of the TRX modules (and the Reference module) within it. Each module is calibrated independently, and not necessarily at the same time that the others in the test set are calibrated.

The only way to track the calibration status of the E6640A is to track the calibration status of the reference module, and each TRX module, within it. The serial number of a particular module can be found from its XSA window, by selecting **System Settings > System > Show Hardware**. The serial number is listed in the row which shows “Reference” or “M943x TRX” under Assembly Name. The same row also shows the Cal Date for the relevant module.

The same hardware information is also returned by the SCPI command:

**SYST:CONF:HARD?**
Certificates of Calibration

Customers receive 2 to 5 Certificates of Calibration (COCs) with the E6640A EXM test set. The EXM is a scalable test set and can be purchased with 1 to 4 TRX modules. The TRX modules, along with the Reference module (supplied with each E6640A), are the only items that require calibration, and therefore they are the only items supplied with a CoC and calibration sticker at shipment.

Each E6640A test set is shipped with a yellow envelope which contains your calibration certificates; this envelope is labeled (lower right corner) with a sticker identifying the unit model number (E6640A) and serial number. Inside each envelope will be from two to five CoCs: one for the reference module, and one for each of the TRX modules installed in the test set. This package constitutes your test set’s calibration data.

![Certificates of calibration](image)

You may choose to physically attach calibration stickers to your E6640A test set (recommended), or, as many customers do, you may choose to use the modules’ electronic calibration information to identify the calibration status of any module at any time. The use of electronic calibration information is of benefit to those customers that may want to move modules from one instrument to another: the calibration date always follows the module.

To summarize: calibration of the E6640A is not done at the instrument level, but an E6640A is fully calibrated when all of the modules (Reference module and TRX modules) are calibrated. At initial shipment, this information is provided in the yellow envelope supplied with each unit.
Desktop Icons

Five desktop icons provide access to utilities which support the E6640A's measurement firmware.

Figure 4-6 Desktop icons

- Configure Applications MultiTouch
- Launch XSA Applications MultiTouch UI
- TRX Configurator
- Configure Applications
- Launch XSA Applications
TRX Configurator

The TRX Configurator tool shows which of the four possible TRXs are installed in the PXIe rack, and identifies them by SCPI address. At a minimum, TRX1 must be installed, and cannot be disabled using this tool. However, the other TRXs, if installed, can be enabled or disabled using the checkbox in the right column.

Figure 4-7  The TRX Configurator

<table>
<thead>
<tr>
<th>TRX #</th>
<th>HW Installed</th>
<th>TRX SCPI Address</th>
<th>xSA Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRX 1</td>
<td>Installed</td>
<td>TCP/IP: K-E6640A-00099::inst0::INSTR</td>
<td>☑ Enable?</td>
</tr>
<tr>
<td>TRX 2</td>
<td>Installed</td>
<td>TCP/IP: K-E6640A-00099::inst1::INSTR</td>
<td>☑ Enable?</td>
</tr>
<tr>
<td>TRX 3</td>
<td>Installed</td>
<td>TCP/IP: K-E6640A-00099::inst2::INSTR</td>
<td>☑ Enable?</td>
</tr>
<tr>
<td>TRX 4</td>
<td>Not Installed</td>
<td></td>
<td>□ Enable?</td>
</tr>
</tbody>
</table>

The **UpdateFPGA** button is used when installing a new TRX into an E6640A which was purchased without it, to ensure software compatibility.
Launch XSA MultiTouch

Only the 5G NR application is currently supported in the MultiTouch interface.

If you have closed any of the XSA application windows, you can reopen them without rebooting, by clicking the Launch XSA MultiTouch icon. This will only open a window for a given TRX if it is enabled in the TRX Configurator.
Configure Applications MultiTouch

Click the Configure Applications MultiTouch icon to launch this utility, which allows you to specify which of the E6640A's measurement applications (in the MultiTouch user interface) will be preloaded into memory at startup. Preloading the most frequently-used applications is a convenience (however, selecting fewer of them for preload shortens the startup time and uses less memory).

Figure 4-9 Configure MultiTouch applications

A selector at the lower left of the window allows you specify which application will be running when the E6640A starts up.
Minimized Windows

Minimized windows can be reopened by finding the icon representing them in the Windows taskbar.

Figure 4-10  Reopening minimized windows
Port Configuration

Any of the TRXs four RF ports can be configured as an input port (accepting a signal to be analyzed) or as an output port (providing an RF stimulus).

If the test set was purchased with Option 4FD, the TRX model used is M9433A, and ports RFIO 1 through RFIO 4 connect to the source and analyzer through a splitter/combiner rather than a switch; therefore, they can be used in full-duplex mode (that is, with a given port used for both input and output simultaneously). These ports can also be configured as input-only, or output-only.

Option 4FD is currently a requirement for the 5G NR test application, which is not supported on the M9432A TRX. For that reason, the M9432A is not discussed in this chapter; see “Port Configuration” on page 60 for information on port configuration for that type of TRX.
Full Duplex Port Setup

If the test set was purchased with Option 4FD, then each of the IO ports connects to a splitter/combiner rather than a switch, and it can be used in full duplex mode, as a simultaneous input and output. In the example illustrated below, the RFIO 2 port is used in this way. (Other ports could be selected simply by substituting different port names in the instructions provided below.)

Figure 4-11  RFIO 2 on M9433A used in full duplex mode

To use the RFIO 2 port as the input and output, set up the RF Input using this menu setting or its equivalent command:

**Input/Output > Input > RF Input Port > RFIO 2**

Command:

`:FEED:RF:PORT RFIO2`

Then set up the RF Output using this menu setting or its equivalent command:

**Input/Output > RF Source > RF Output > RFIO 2**

Command:

`:FEED:RF:PORT:OUTP RFIO2`
Separate Input and Output Port Setup

Although, with Option 4FD, all of the RFIO ports are designed to operate as full-duplex ports, they can function as separate inputs and outputs. In this example, the RFIO 2 port is used as an input, and the RFIO 3 port as an output. (Other port combinations could be selected simply by substituting different port names in the instructions provided below.)

Figure 4-12  RFIO 2 on M9433A used as input, RFIO 3 as output

To use the RFIO 2 port as the input and the RFIO 3 port as the output, set up the RF Input using this menu setting or its equivalent command:

**Input/Output > Input > RF Input Port > RFIO 2**

Command:

```plaintext
:FEED:RF:PORT RFIO2
```

Then set up RFIO 3 as the RF Output, using this menu setting or its equivalent command:

**Input/Output > RF Source > RF Output > RFIO 3**

Command:

```plaintext
:FEED:RF:PORT:OUTP RFIO3
```
The E6640A supports both dynamic and static assignment of its IP address, using ports LAN 1 and LAN 2 respectively.

The LAN 1 port is designed for dynamic IP addressing, using the Dynamic Host Configuration Protocol. If your site network supports DHCP, the E6640A will be assigned an IP address automatically when it is connected to the LAN. Once the address is assigned, it is listed, along with the computer name, under System > Show > System. The address or computer name can be used to find the test set on the LAN. However, to see the System > Show > System screen and find this information, it is necessary either to connect a monitor to the front panel monitor port, or else to use the LAN 2 port to connect test set to a PC directly.

Using the LAN 1 port to connect the test set directly to the public LAN is potentially insecure, because the test set does not provide anti-virus protection. Connecting the test set to the public LAN by way of a PC with antivirus protection is the preferred solution.

The LAN 2 port is designed to use a private static IP address, 192.168.1.2 (changing this address is possible but not recommended). This port can be used for direct connection to a PC.

To find the test set on the LAN, you will need to know its IP address or computer name. If you cannot easily obtain a monitor view of System > Show > System, you can determine the computer name using the instrument serial number. The computer name is in the format K-E6640A-nnnnn, ending in the last five digits of the serial number.
5 Test Set Operating System

The following topics can be found in this section:

“Keysight Software Installed” on page 112
“Customer Installation of Software” on page 113
“User Accounts” on page 114
“Keysight Licensing Options” on page 116
“Licensing New Measurement Application Software - After Initial Purchase” on page 118
“Transporting a License Between Test Sets” on page 120
“Windows Configuration” on page 123
“Configuring Printers” on page 126
“Configuring LAN” on page 126
“Windows Security” on page 127
“System Maintenance” on page 131
“USB Connections” on page 132
“Hard Drive Partitioning and Use” on page 134
“Hard Drive Recovery Process” on page 135
Keysight Software Installed

Measurement Software Applications

A set of Keysight measurement applications for different modes (GSM/EDTE, cdma2000, Sequence Analyzer mode, etc.) is installed by default in the test set, but these must be licensed in order to be used. Whichever licenses were purchased with the instrument are installed at the factory (see “Options and Licenses” on page 13. Other licenses can be purchased and installed later (including transportable licenses). For more information, see:

http://www.keysight.com/find/e6640a
Customer Installation of Software

3rd party software verified by Keysight

Keysight has verified that the following programs are compatible with the test set applications:

- Symantec AntiVirus™ Corporate Edition version 10
- MathWorks MATLAB

Installation of other 3rd party software

The E6640A platform is an open Windows environment, so you can install non-approved software on the test set. However, installation of non-approved software may affect test set performance. Keysight does not warrant the performance of the test set with non-approved software installed.

NOTE

Before installing any additional programs on the test set, you should exit the test set application.

Also, you must not remove any applications or programs that are installed on the test set when it is shipped from the factory.

If you install programs other than those that Keysight has tested, it could cause problems with the test set's applications. If this happens, you should try uninstalling the program that has caused the problem, or try changing the program's configuration. If this does not correct the problem, you may have to use the Keysight Recovery system to reinstall the test set's system software.
Test Set Operating System
User Accounts

User Accounts

Administrator login

The Administrator account ships from the factory with the password “Keysight4u!”. Using the Administrator account, you can perform the following operations:

- Install software
- Configure network and printer access
- Access all files on the test set
- Add or change user accounts and passwords
- Change Firewall settings
- Change Windows settings (for example, using Device Manager)
- Change the time and date
- Run any application

NOTE
The E6640A was formerly a product of Agilent Technologies. If the front panel of the test set shows Agilent as the manufacturer, then “agilent4u” may have been set as the password for the Administrator account.

User login

The default user account that ships from the factory is “Instrument” with the password “measure4u”. This user is a member of the Power Users group. Using the Instrument account you can perform the following operations:

- Install software
- Configure network and printer access
- Access files on the test set that are accessible to the Power Users group
- Run applications that are accessible to the Power Users group
Customer creation of accounts

You can create additional user accounts and decide on the level of security granted to any new user accounts created. For example, the level of security can be assigned as administrator, power user, user, backup operators. User names are not case sensitive but passwords are case sensitive.

**NOTE**

For the test set software to operate, the user account executing the software must be assigned Administrator or Power User privileges. Otherwise, the test set software will not operate correctly.

It is Keysight’s expectation that each user’s My Documents folder is mapped to the D: drive. This is to avoid overwriting the user’s data in the event the Keysight Recovery must be performed. Also, this facilitates convenient backup by copying the contents of the D: drive to external media. All users accounts created by the factory already have My Documents mapped to the D: drive. Please map all new users My Documents folders to the D: drive.
Keysight Licensing Options

Keysight test sets use three licensing types: Fixed Perpetual, Transportable Perpetual, and Trial. Fixed Perpetual licenses are also required to enable hardware options.

**Fixed Perpetual**

Fixed Perpetual licenses are the traditional license type (Fixed) with the same duration (Perpetual) that have been available for all features since the Keysight X-Series introductions. Fixed Perpetual licenses are identified by the “F” in the second character and “P” in the third character of the option designator:

Example: V9079B-1FP

A license key is instrument model and serial number dependent. You can only install the license key on the specific instrument for which it was created.

**Transportable Perpetual**

Transportable Perpetual licenses are an optional license type offering deployment duration which is not fixed to a specific instrument model and serial number. Transportable Perpetual licenses are identified in the product structure by a “T” in the second character and “P” in the third character of the option designator:

Example: V9079B-1TP

Transportable Perpetual licenses require a connection to the Keysight server only for managing the check-in/out of the license. The Keysight licensing server also provides for storage of unused licenses which have been transported off instruments but are awaiting assignment to new instruments. The server will limit the number of transports per 30 day period per application license to 10.

Unlike Fixed Perpetual licenses which are pre-installed at the factory with new instrument purchases, Transportable Perpetual licenses require redemption and installation of the license before the first use. This allows the user to determine on which instrument to initially install the application license.

Keysight recommends that instruments be at the same instrument software release to ensure the latest code is available on each instrument so that the user experience is identical between instruments. This is particularly important when transporting the license for a newly-released application which may only be available in the latest software release.

**Time-Limited Licenses (Trial Licenses)**

Trial licenses are available so that you may try applications before you buy the full applications. These licenses are time limited for a 30 day period, and are restricted to one trial for an individual application per instrument. The restriction is enforced through the license redemption process of the Keysight Software Manager (KSM) system.
Test Set Operating System  
Keysight Licensing Options

Trial licenses are only available for measurement applications and not available for enabling hardware capability.

Trial licenses are not installed in the factory and no entitlement certificates are created for distribution with new instrument shipments. Trial licenses are not available for order, but are available from the Keysight Web site after completing a brief registration:

http://www.keysight.com/find/e6640a

(Go to the Licensed Software tab and click View Details. Go to the Trials & Licenses tab and click Apply for a Free Trial.)

Trial Licenses are identified (in Keysight License Manager) by the license designator “-TRL”.

Example: V9079B-TRL

If a product has multiple tiers (levels of functionality), the -TRL license enables all tiers for the duration of the license. If you have a base tier and want a trial license for a higher tier, you can install the -TRL license. When the duration expires the entitlement is reverted back to the base tier.
Licensing New Measurement Application Software - After Initial Purchase

Additional measurement application software can be ordered after your initial purchase of the E6640A test set. Software upgrades are provided in a kit that includes an option based Entitlement Certificate, a license agreement. The licenses are downloaded from the license Web site onto a storage device so they can be loaded into the instrument.

If you do not want to wait for your upgrade kit to arrive, licenses can be installed using any available USB storage device. If you choose to do this, we recommend that the latest version of the instrument software be installed. This ensures that the measurement application being licensed and activated is installed and is the most current version.

The latest revision of the software may be downloaded from: http://www.keysight.com/find/e6640a

A license key is usually for one instrument model and serial number combination. The license key will only install itself on that instrument.

**NOTE**

No calibration is required after a test set application installation.

### Installation procedure over USB

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Redeem the Option Upgrade Entitlement Certificate</td>
<td>Follow the instructions on the Certificate. After redeeming your Option Upgrade Entitlement Certificate you will receive an e-mail with an attached License File.</td>
</tr>
<tr>
<td>2</td>
<td>Save the license file</td>
<td>Save the .lic file to the root directory of a USB storage device.</td>
</tr>
<tr>
<td>3</td>
<td>Load the license file</td>
<td>Connect the USB storage device to one of the test set USB ports. Windows will detect the new hardware and may display the configuration menu. The test set automatically loads the license file. (This may take a few minutes) Upon completion, the Keysight License Manager displays a “Successful License Installation” message.</td>
</tr>
</tbody>
</table>

**NOTE**

Alternatively the license file can be manually installed over USB or LAN by placing the license file in the following folder on the test set.

C:\Program Files\Agilent\licensing
## Test Set Operating System
### Licensing New Measurement Application Software - After Initial Purchase

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Verify installation</td>
<td>Cycle the power on the signal test set. &lt;br&gt;On the Virtual Front Panel press <strong>System</strong>, <strong>Show, System</strong>. &lt;br&gt;Verify that the new application appears in the list.</td>
</tr>
</tbody>
</table>
Transporting a License Between Test Sets

Transportable licenses can be identified by the letters "TP" in their option designator. For example, V9079B-2TP indicates the license is transportable and perpetual. To transport this license from one test set to another, Keysight recommends that both test sets be at the same instrument software release. This ensures that the user experience is identical between instruments.

As a minimum, the instrument software release in the test set that will receive the transportable license (the "target instrument") must at least be able to support the desired application.

The E6640A test sets support several ways of transporting licenses. The procedure below will focus on the most common procedure, where neither of the test sets has access to an internet connection.

This procedure requires a PC with an internet connection.

You will need the following:
- USB flash drive
- USB keyboard
- USB mouse

The test set from which the transportable license will be removed is here called the "source instrument". The test set which will receive the transportable license is here called the "target instrument".

Procedure for Transporting a License, Neither Test Set Connected to the Internet

The test set from which the transportable license will be removed is here called the "source instrument". The test set which will receive the transportable license is here called the "target instrument".

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Connect the USB devices to the source instrument</td>
<td>Connect the USB flash drive, USB keyboard, and USB mouse to the USB ports on the source instrument. It will be necessary to use one or more of the front panel ports to connect the USB devices.</td>
</tr>
<tr>
<td>2</td>
<td>Verify software version in each test set</td>
<td>On the Virtual Front Panel for each test set, press System &gt; Show &gt; System and make note of the Instrument S/W Revision on each. Ideally, the revisions will be the same. But at least, both versions should be able to support the application whose license is being transported.</td>
</tr>
</tbody>
</table>
### Test Set Operating System

**Transporting a License Between Test Sets**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>3. Obtain the Host ID from the Target Instrument</td>
<td>On the target instrument, press <strong>System &gt; Show &gt; System</strong> and make note of the host ID.</td>
<td>This information will be needed to issue the license for the target instrument. The Host ID is the model number, followed by a comma, followed by the serial number.</td>
</tr>
<tr>
<td>4. Start the License Manager on the Source Instrument</td>
<td>On the source instrument, press <strong>System &gt; More &gt; Licensing...</strong>&lt;br&gt;It may take a minute for the Keysight License Manager screen to be fully populated with all the installed licenses.</td>
<td></td>
</tr>
<tr>
<td>5. Transport the Transportable License from Source Instrument</td>
<td>On the source instrument, locate the desired license to be transported and highlight it. Its option designator should include the letters &quot;TP&quot;.&lt;br&gt;Right-click on the mouse and select <strong>Delete</strong>.&lt;br&gt;Click <strong>Yes</strong> in the License Deletion Confirmation dialog box.&lt;br&gt;After a few seconds, a Transport License dialog box will appear. Click <strong>OK</strong> and save the *.url files on the USB flash drive, with a name such as &quot;PhaseNoise_License.url&quot;.</td>
<td>Be sure you are selecting a transportable license and not a fixed perpetual license. Although you are &quot;deleting&quot; the transportable license, the ultimate action will be to transport it. The information in this dialog box will be used to issue a new license for the target instrument.</td>
</tr>
<tr>
<td>6. Get New License from KSM Transportation Web page</td>
<td>Insert USB flash drive into PC that is connected to the internet.&lt;br&gt;On the PC, locate the *.url file on the USB flash drive that was saved in the previous step and click on it.&lt;br&gt;After a few seconds, the KSM Transportation Web page will appear. One field, the New Host ID will be empty.&lt;br&gt;Enter the Host ID of the target instrument (step 3 above) into the field marked New Host ID.&lt;br&gt;Click <strong>Submit</strong>.</td>
<td>The PC must have an internet connection and an available USB port. Most of the fields have been populated from the information in the *.url file. Be very careful when entering the New Host ID. A mistake made in entering the New Host ID will result in an invalid license being issued. Be sure there is a comma between the model number and serial number. There should be no spaces in the Host ID.</td>
</tr>
</tbody>
</table>
### Step 7: Save License File to USB Flash Drive

<table>
<thead>
<tr>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>The KSM Transportation Web page will indicate that a license file is available and display two links to the license file. Right-click on the license file and select <strong>Save Target As...</strong></td>
<td>Either link can be used to either display or save the license file.</td>
</tr>
<tr>
<td>Save the license file to the root level of the USB flash drive, keeping the &quot;lic&quot; file extension.</td>
<td>The license file must be saved to the root level of the USB flash drive for it to be recognized by the target instrument.</td>
</tr>
<tr>
<td>Close the Save dialog and exit the KSM Transportation Web page.</td>
<td></td>
</tr>
</tbody>
</table>

### Step 8: Install License File in Target Instrument

<table>
<thead>
<tr>
<th>Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>With the target instrument running, insert the USB flash drive into one of the front panel USB ports. After a few minutes, you should see a message saying &quot;Successful License Installation&quot;.</td>
<td>The Keysight License Services running on the target instrument looks for *.lic files whenever it detects a USB device has been inserted. If the contents of the *.lic file are appropriate for the instrument, the license will be installed automatically.</td>
</tr>
<tr>
<td>Cycle power on the target instrument.</td>
<td>Newly-installed licenses are only recognized by the instrument software on power-up.</td>
</tr>
<tr>
<td>Once the test set has re-booted, the application should be ready to use on the target instrument.</td>
<td></td>
</tr>
</tbody>
</table>
Windows Configuration

The Windows settings have been optimized for the best measurement performance. Any modifications to these settings may degrade test set performance and measurement speed. In general, most Windows System settings (typically set through the Windows Control Panel) should not be modified. Those that can be safely modified are listed below.

**CAUTION**

To recover from problems caused by changing Windows systems settings, you may have to reinstall the Windows system and test set application using the Keysight Recovery process.

### Settings that can be changed

You may change the following Windows settings or administrative tasks (available from the Windows Control Panel) to select your personal preferences.

Before changing any Windows System settings, exit the test set application.

<table>
<thead>
<tr>
<th>You may use this feature</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Windows Update]</td>
<td>Configure Microsoft Windows Automatic Updates.</td>
</tr>
<tr>
<td>![Action Center]</td>
<td>Install and configure an Anti Virus program.</td>
</tr>
<tr>
<td>![User Accounts]</td>
<td>Set up new test set user accounts.</td>
</tr>
<tr>
<td>![Network and Sharing Center]</td>
<td>Add the test set to a network.</td>
</tr>
<tr>
<td>![Devices and Printers]</td>
<td>Install and configure a printer.</td>
</tr>
<tr>
<td>![Date and Time]</td>
<td>Set the time and date.</td>
</tr>
</tbody>
</table>
### Settings that must not be changed

Avoid changing any settings in this section. Changes to the following settings may degrade test set performance, screen displays, and measurement speed.

<table>
<thead>
<tr>
<th>Do NOT use this feature</th>
<th>To do this...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power Options" /></td>
<td>Do not change Power Options.</td>
</tr>
<tr>
<td><img src="image" alt="System" /></td>
<td>Do not modify System Properties, Hardware Tab settings. Do not modify System Properties, Advanced Tab settings (except as recommended under &quot;Settings that can be changed&quot; above).</td>
</tr>
<tr>
<td><img src="image" alt="Fonts" /></td>
<td>Do not remove installed Fonts.</td>
</tr>
</tbody>
</table>
| ![Display](image)      | Do not change the following Display Settings:  
  - Screen Saver settings (under “Personalization”)  
  - Screen resolution, 1024 x 768 (under “Adjust Resolution”)  
  - DPI setting (under “Set custom text size”) |
| ![Region and Language](image) | Do not change any settings under “Region and Language” or the instrument keyboard and display may not operate properly |
| ![User Accounts](image) | Do not delete or modify the “KeysightOnly” or “AgilentOnly” user account. |
Test Set Operating System
Windows Configuration

In addition, **DO NOT**:

- Add, delete, or modify hard-disk drive partitions.
- Delete or modify Agilent/Keysight registry entries.
- Change the contents of any directories containing the name “Agilent” or “Keysight”.
- Stop these services:
  - The MSSQL$CDF service or uninstall the “Microsoft SQL Server Desktop Engine”
  - The IIS server or tamper with any virtual directories (or their contents) that came configured with the test set.

- Uninstall these libraries, interfaces, or programs:
  - The Agilent/Keysight I/O Libraries
  - The .NET Framework or any Hotfixes or Service Packs for the .NET Framework
  - The “Microsoft Visual J# .NET Redistributable Package 1.1”
  - Programs that begin with "Agilent” or “Keysight”
  - The Adobe Acrobat Reader

- Modify
  - The Agilent/Keysight I/O Library “GPIB27”, “GPIB28” interfaces shown as configured Instrument I/O in the Agilent/Keysight Connection Expert or I/O Config.
Configuring Printers

Printers are configured using the Microsoft Windows Control Panel. It is easily accessed from the Windows Start menu or from under the front panel System key. This setup process is most easily done using a USB mouse and an external keyboard.

When setting up a new printer, you may need to load the printer driver (unless you are using a network printer that your IT department has set up to include the driver). The manufacturer of the printer supplies the driver software and process. That may require that you attach an external USB disk drive. An alternative is to connect the test set to the LAN and download the driver from the printer manufacturer’s internet site.

Configuring LAN

Hostname

The Computer Name, or hostname, is pre-configured from the factory. It must be a unique name so that it does not conflict with other equipment on your LAN. The pre-configured Computer Name is K-E6640A-xxxxx, where xxxxx represents the last 5 digits of the test set serial number.

To change the Computer Name consult the Microsoft Windows Help and Support Center.

IP Address & Gateway

The test set is pre-configured to obtain an IP Address using DHCP. The IP Address and Gateway can be changed. Consult the Microsoft Windows Help and Support Center to configure the LAN.
Windows Security

Microsoft recommends the following to ensure the test set Windows operating system is protected:

– Use an internet firewall.
– Get the latest critical Windows updates.
– Use up-to-date antivirus software.

To check the status or make changes in the security settings for your test set, click **Start, Control Panel, and then System and Security**. The following window appears:

**Figure 5-1 System and Security settings**

![Image of System and Security settings]

**NOTE**
The window may look slightly different on your test set.
Windows Firewall

Click **Windows Firewall** in the System and Security window to check the firewall status of your test set. The test set is shipped with the Windows Firewall enabled.

**Figure 5-2**  
Firewall settings

The window may look slightly different on your test set.

**NOTE**

Windows Firewall exceptions for programs and ports have been added to allow proper operation of the test set over a network. Modifying these settings may prevent the test set from operating properly.
Test Set Operating System
Windows Security

Automatic updates

Keysight recommends installing Windows updates. This should be enabled in Windows security settings. The default test set setting is to automatically check for critical Windows Updates and notify you, if the test set has internet access.

You can change the configuration of the Microsoft Automatic Updates. Under Windows Update in the System and Security window, click Turn automatic updating on or off to change settings. If you choose not to have automatic updates, you can manually update windows by clicking Check for updates on the System and Security window.

![Automatic update settings](image)

**Figure 5-3** Automatic update settings

Be aware that downloading and installing Windows Updates can be network and CPU usage intensive (impacting the test set performance), and some Windows Updates automatically reboot the test set. It is recommended that Windows Updates be performed when the test set is not in normal use.
Virus protection

Under **Action Center** in the **System and Security** window, click **Review your computer's status and resolve issues** to check the status of virus protection on your test set. There is no antivirus software included with your test set. Antivirus application software has been tested to be compatible with the test set. See the section on “**3rd party software verified by Keysight**” on page 113 for anti-virus software that has been tested by Keysight.

**NOTE**

Having antivirus software installed may have a slight impact on the test set performance.

---

**Figure 5-4**  Virus protection settings

![Virus Protection Settings](image)

Spyware protection

The **Review your computer's status and resolve issues** window described above also shows the status of spyware protection. There is no anti-spyware software installed on the test set. This should not be a problem if you do not use the test set for a lot of internet browsing. Having spyware in the test set could have an impact on the test set performance.
System Maintenance

Backup

It is recommended that you have a regular backup strategy. Your IT department may already have a backup strategy in place which is suitable for the test set and its data. Using the Keysight Recovery system in conjunction with a regular backup strategy should allow full recovery of the test set data.

The Windows operating system has a Backup utility that you can use to archive files and folders in case of a hard disk drive failure. See the Microsoft Windows Help and Support Center for more information on this utility. You can also use third party backup utilities. However, you must ensure that this third party software is compatible with the test set's system software. See “Customer Installation of Software” on page 113 for more information.

When performing backups, we recommend that you backup the data to an external storage device connected to the network or one of the test set's USB connectors. Also, you should perform backups at times when the test set is not being used for normal operations as it may impact the test set's overall performance.

System restore

Windows contains the capability to restore the system to a previous point in time. System Restore is enabled with default settings as provided by Microsoft. However, System Restore is not 100% successful. Therefore, it is not the recommended method to backup the test set. System Restore has not been tested to verify successful restoring.

Disk defragmenting

Over time the hard disk on the test set becomes fragmented. Windows has a Disk Defragmenter utility that you can use to defragment the hard disk. See the Microsoft Windows Help and Support Center for more information on this utility.

NOTE

Running Disk Defragmenter should be performed when the measurement application is not running. Measurement throughput is significantly impacted while disk defragmentation is in process.
USB Connections

The controller front panel provides two USB 3.0 ports and four USB 2.0 ports to which you can connect USB mass storage devices and accessories such as printers and keyboards. The test set USB Host support includes the standard Microsoft Windows USB class drivers for human interface, mass storage, printing, scanning, and imaging devices. A complete up-to-date list of the Windows USB class driver support is available on the Microsoft website:


The test set USB device driver included in the test set software supports the test and measurement industry standard USBTMC-USB488 device class.

In addition, the Agilent/Keysight IO Libraries that is installed on your test set contains USB Host drivers that allow control of other test sets connected to the USB bus.
Test Set Operating System
USB Connections

Keysight Technologies does not support or warrant correct test set operation if additional USB drivers from third parties are installed in the test set. It is possible that additional drivers could break the normal USB operation. If USB operation is broken, recovery would require reinstalling the test set application using the hard drive recovery process.
Hard Drive Partitioning and Use

The drive is partitioned into 3 sections: C:, D: and E:

- The **C: partition** contains the Windows operating system and software installed by Keysight. This is an Open System which means you can install additional software, and these should be installed on the C: drive. However, only a limited set of software applications are tested for use with the Keysight measurement software. The installation and/or use of other software is not warranted, and could interfere with the operation of the measurement software. If test set repair is ever needed, the Keysight version of the C: drive is the only part of the test set software that is restored by the Keysight Recovery process. You must reload any other software that you have added in the test set.

- The **D: partition** is reserved for data storage. Additionally, this drive is used to save customer waveforms and to save custom instrument states. The User Accounts that are configured by Keysight have their My Documents folder mapped to the D: drive. This is for the convenience of backing-up the measurement data. You should always back-up the data on the D: drive to an external device. This allows you to restore the data if you ever need to replace the hard drive.

- The **E: partition** is reserved for Keysight’s use. The primary use of the E: drive is for housing the Calibration and Alignment data. Do not change or overwrite the files on this drive. This could cause your test set to not meet specifications, or even to stop functioning correctly. Do not use this drive for data storage. It is also recommended that you back up the contents of this drive by using the factory calibration data backup utility.
Hard Drive Recovery Process

The Keysight Recovery System can be used to repair errors on the test set's C: drive partition, or to restore the original factory configuration of the system software. The Keysight Recovery System is stored in a separate hidden hard disk drive partition.

Repairing errors on the hard disk drive may result in loss of data or files. If you need more information about the Windows “chkdsk” error repair process, see the chkdsk documentation in the Microsoft Windows Help and Support Center.

Restoring the original factory system software does not restore any of the following items:

- Windows system configurations that were made after the test set was shipped from the factory. For example, Windows and Service Pack updates, user accounts, and Windows configuration settings. After an Keysight Recovery, these configurations need to be redone.
- Additional software that was installed after the test set was shipped from the factory. After an Keysight Recovery, that software needs to be re-installed.
- Any data or programs saved on the D: or E: drives.
- Any upgrades that were made to the Keysight measurement application software.

Restoring the original factory system software will not synchronize the code in the Field Programmable Gate Arrays (FPGAs) on the various hardware assemblies. As a result, you may see an error dialog box appear during the final boot-up at the end of the recovery process. This typically occurs when there are significant differences between the software version installed prior to performing the recovery and the version restored by the recovery. In these situations, upgrade the software to the latest version.

NOTE

It is recommended that you use a regular back up strategy. Your IT department may already have a back up strategy in place which is suitable for the test set and its data. See “System Maintenance” on page 131. Using the Keysight Recovery System in conjunction with a regular back up strategy should allow you to fully recover the test set software and data.

It is recommended that routine backups of the test set information be performed to keep current archives of the test set information. This allows a full recovery of the test set information after the test set recovery system operations are performed. See “Backup” on page 131 for more details.
### Table 5-1 Using the test set recovery system

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Make sure the test set is turned off.</td>
</tr>
</tbody>
</table>
| 2    | **Turn on the test set.**  
Press the down arrow key to move the highlight to Keysight Recovery System, then press **Enter**.  
After the Keysight Technologies screen is displayed, this screen is displayed for five seconds. |
| 3    | When the Keysight Recovery System has booted, follow the on-screen instructions to recover the image of the C: drive.  
Press **2**, then press **Enter** to select the recovery.  
Press **1**, then press **Enter** to continue.  
Press **1**, then press **Enter** to confirm.  
It may take up to 25 minutes for this process to complete. |

After exiting the Keysight Recovery System, the test set reboots. If the original factory test set system has been restored, the test set re-executes the following process: **“Turning on the test set the first time” on page 17**.

---

**NOTE** Additional recovery steps may be required to fully recover the system to a more current working state. This could involve restoring your own backups of the test set configuration, including re-installing applications, data, and performing system customizations.
Updating the software

The purpose of this update is to ensure that the E6640A's software, its measurement mode applications, and the FPGA content of its PC boards are all current and up to date.

NOTE

An update to the instrument software revision does not require a new license key for the measurement applications, so long as the applications were licensed prior to the update.

NOTE

This procedure will only update the instrument software that currently resides on the C: drive of the instrument. It will not update the version that exists on the recovery partition. Because of this, if the recovery process is performed, the instrument will revert back to the instrument software revision that was originally shipped from the factory.

Determining the current software revision

To determine what revision of instrument software is currently installed, press System, Show, System using the instrument’s virtual front panel. You can access the virtual front panel using a mouse and right-clicking in the application window, and selecting Utility, Virtual Front Panel. Once in the show system screen, look for the "Instrument S/W Revision" entry (for example: "A.13.85"). If the installed revision is the same as the latest revision on the web, there is no need to update the instrument software.

Requirements

The following requirements must be met to use this procedure:

– The E6640A must be functioning properly before the update is attempted.
– You must have a USB keyboard and mouse.
– You must be able to log in to the instrument as the administrator.
– You must be able to transfer a large file (~1 GByte) to the E6640A being updated.
File Download

1. Go to [http://www.keysight.com/find/e6640a](http://www.keysight.com/find/e6640a) and go to the Technical Support section; select the Driver, Firmware & Software tab.

2. Download the executable file by clicking on the file link. Save the file to a location of your choice. If you do not have the ability to download files directly to the C: drive of the E6640A being updated, store the file on a large capacity USB storage device for transfer to the instrument. (The file size is ~1 GByte.)

User account and log-in

The default user account is Instrument, which does not have the required permissions to install the instrument software updates. For the process outlined below, the user must be logged in as Administrator.

The automated instrument software upgrade process has an install wizard which removes the old software version and installs new software version without manual steps. The removal of the old software version and the installation of the new software version completes in approximately 15 minutes.

1. Connect a USB keyboard and mouse to the E6640A.

2. If the E6640A is not already running, power it up and allow it to boot up completely.

3. Close the E6640A measurement application if it is running. Right-click in the application window, and select elect Utility > File from the right-click menu; select the Exit softkey and click OK in the confirmation window.

4. Log out as the default user (Instrument). Click the Start icon at the lower left corner of the screen, and select Log Off.

5. Select the Administrator icon on the Windows desktop, to log in as follows:
   - User Name: administrator
   - Password: Keysight4u!

6. If a “Found New Hardware” wizard window pops up, select “No, not at this time” to bypass the activity.
Instrument software installation

If you downloaded the instrument software update file to the instrument via LAN, access that file from the location that it was stored and proceed to step 1.

If you downloaded the instrument software update file to a USB storage device, plug that into one of the USB ports on the front of the instrument. Access the file for the removable drive, then proceed to step 1.

During the installation process, the installer may need to obtain software components from external web sites (such as www.microsoft.com). For this reason, it is necessary for the instrument to have internet access via the LAN during installation of the software.

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Double click on the installer file, and click Yes in the confirmation window that appears. The file name is in the format: XSA_Installer_E.XX.XX.exe.</td>
</tr>
<tr>
<td>2</td>
<td>A window appears showing the extraction of the software installer. Click Install in the confirmation window to begin the installation process. When the extraction process is complete, a software updater display appears, showing progress of the software removal and installation. The update process causes various messages and windows to appear and disappear on the screen, but the process doesn't require further interaction. Examples of what will be displayed are shown below, as a guide to what the process looks like while it is running.</td>
</tr>
</tbody>
</table>
Table 5-2  Preparing the installation

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extraction window:</td>
<td></td>
</tr>
</tbody>
</table>

![Image of extraction window](image)

![Image of software updater window](image)

Software updater window, showing uninstallation progress:

```
Welcome to Keysight XSA Software Updater

Uninstall XSA Version E.19.72: .. Uninstall In Progress ... .

Install XSA Version E.21.05:
```

While the old instrument software is being uninstalled, the text “Uninstall in Progress” text rolls across the screen, to be replaced finally by “Completed Successfully”. No interaction is required at this point.
Table 5-2  Preparing the installation

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
</table>

Software updater window, showing installation progress:

<table>
<thead>
<tr>
<th>Welcome to Keysight XSA Software Updater</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uninstall XSA Version E.19.72: Completed Successfully</td>
</tr>
<tr>
<td>Install XSA Version E.21.05: Installation In Progress ……</td>
</tr>
</tbody>
</table>

During installation, various popup windows may appear temporarily, while required software components are downloaded from external sites.

While the new instrument software is being installed, the text "Installation in Progress" text rolls across the screen. No interaction is required at this point.

Please be patient; the total installation process can take 30 to 40 minutes.
During the installation process, an FPGA update warning window (may be displayed, if any FPGA updating occurs):

**NOTE**

During FPGA programming, DO NOT power off the E6640A for ANY reason! Interrupting the FPGA update process can place the instrument in an unusable state, requiring it to be returned to Keysight for repair.

After the installation has completed successfully, a confirmation message is displayed:

- **Welcome to Keysight XSA Software Updater**
- **Uninstall XSA Version E.19.72: Completed Successfully**
- **Install XSA Version E.21.05: Completed Successfully**
- **The software upgrade was successful!**

A mainframe/chassis power shut down and restart is required to complete the process. Please click the Finish button to shut down the system and you must power-on the chassis manually.

**3** A reboot is required following the installation process. Reboot the E6640A by clicking Finish in the window. Windows will display a “System Shutdown” warning window; this is normal.
Getting Started Guide

Test Set Operating System
Hard Drive Recovery Process

Table 5-2 Preparing the installation

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Clicking the “Finish” button results in a Windows shutdown.</td>
</tr>
<tr>
<td></td>
<td><img src="image.png" alt="Image" /></td>
</tr>
</tbody>
</table>

5 After you power the E6640A back on, it will boot up in the default “Instrument” account, perform alignments, and finally display the measurement screen.

If the instrument does not reboot, remove the USB storage device and cycle power. The boot order for the instrument may have been changed in the instrument BIOS previously, and the instrument may be instructed to boot from USB first, and the internal drive second. If this is the case, failure to remove the USB device will result in an error, as the instrument attempts to boot from it.

6 Check for any errors, and verify that the new software version is installed.

In the right-click menu, press System. In the System menu, press Show > System. Look for the line “Instrument S/W Revision”.

<table>
<thead>
<tr>
<th>Instrument S/W Revision:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keysight Technologies</strong></td>
</tr>
<tr>
<td><strong>Keysight EXM</strong></td>
</tr>
<tr>
<td><strong>Product Number</strong></td>
</tr>
<tr>
<td><strong>Serial Number</strong></td>
</tr>
<tr>
<td><strong>Instrument S/W Revision</strong></td>
</tr>
<tr>
<td><strong>Revision Date</strong></td>
</tr>
<tr>
<td><strong>Computer System</strong></td>
</tr>
<tr>
<td><strong>Computer Name</strong></td>
</tr>
<tr>
<td><strong>LAN Port</strong></td>
</tr>
<tr>
<td><strong>IP Address</strong></td>
</tr>
<tr>
<td><strong>IPV6 Address</strong></td>
</tr>
</tbody>
</table>

It is possible a newer version of the instrument software is available on the web at http://www.keysight.com/find/e6640a

**NOTE** Additional recovery steps may be required to fully recover the system to a more current working state. This could involve restoring your own backups of the instrument configuration, including re-installing applications, data, and performing system customizations.
Configuring recovery prompt timing

You can configure the time at which the test set power-up process waits for the selection of the recovery process by performing the following steps:

Table 5-3  | Recovery prompt timing |
---|---|
**Step** | **Notes** |
1. From the Windows Start menu, right-click Computer and click Properties. | This opens the System window. |
2. Click Advanced System Settings in the left pane. | This opens the System Properties window. |
3. In the Startup and Recovery section, click Settings. | This opens the Startup and Recovery window. |
4. Under the System Startup section you can either clear the Time to display a list of operating systems check box, or, select the Time to display recovery option when needed check box, and change the delay setting in seconds. |

**NOTE** You must be logged in as an administrator to change these settings. See “User Accounts” on page 114 for more information.
6 Windows Operating System

The following topics can be found in this section:

“Navigating Windows Without a Mouse” on page 146
“Remote Desktop: Using the Test Set Remotely” on page 147
“Programmatic Control of the Test Set” on page 162
“Capturing/Printing Displays and Windows” on page 163
“Windows Shortcuts and Miscellaneous Tasks” on page 164
Navigating Windows Without a Mouse

Table 6-1  Key functions

<table>
<thead>
<tr>
<th>Key Presses</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc</td>
<td>Exits/closes a Windows dialog box (does not exit an Application window)</td>
</tr>
<tr>
<td>Enter</td>
<td>Does the current &quot;default action&quot;. If a menu item or a button is currently highlighted, then the Enter key activates that menu item or button.</td>
</tr>
<tr>
<td>Alt</td>
<td>Moves focus/control to the pull down menus bar in the active Window</td>
</tr>
</tbody>
</table>
| Right Arrow | In pull-down menu: opens the next menu to the right, or opens a submenu  
               In a dialog box: selects an option button |
| Left Arrow  | In pull-down menu: opens the next menu to the left, or opens a submenu  
               In dialog box: selects an option button |
| Up Arrow    | In pull-down menu: Moves to next selection up in the menu  
               In dialog box: selects an option button |
| Down Arrow  | In pull-down menu: Moves to next selection down in the menu  
               In dialog box: selects an option button |
| Tab         | In dialog box: moves to the next/previous field |
| Del         | Deletes the currently selected item |
| Alt + Tab   | Switches between the next/previous Application |
| Alt + Enter | Shows the Properties of the currently selected item |
| Alt + Esc   | Cycles through items in the order that they had been opened |
| Backspace   | In My Computer or Windows Explorer: move up one level  
               In Internet Explorer: works like the BACK arrow key |
| Ctrl + Left arrow | Moves to the left one word at a time |
| Ctrl + Right arrow | Moves to the right one word at a time |
| Ctrl + Tab  | In dialog box: moves to the next/previous Tab location |
| Alt + Space | Opens the window control menu for the currently active window, allowing you to minimize, maximize, move and restore (size) the window |
| Ctrl + Esc  | Opens the Windows Start Menu |
| Ctrl + Alt + Delete | Opens the Windows Task Manager |
Remote Desktop: Using the Test Set Remotely

Windows Remote Desktop is recommended for remote control of the test set.

The Remote Desktop functionality is a Microsoft Windows capability. The following discussion provides some guidelines for using this capability with the test set. You need to refer to the Windows help documentation for more information. As Windows evolves, these instructions may no longer be exact.

Overview of Remote Desktop operation

Using the Remote Desktop functionality of the test set allows you to control and interact with the test set from a remote computer, as though you were sitting in front of the test set.

When you have configured the test set for remote connectivity, and configured a separate computer to act as a Remote Desktop Host, you can send commands to the test set from the remote computer, and you can see the test set display on the screen of the remote computer.

This section provides full details of how to set up the test set for remote connectivity, and also how to set up a computer running any 32-bit version of Microsoft Windows as a Remote Desktop Host.
Remote Desktop: Using the Test Set Remotely

Setting up Remote Desktop operation

Setting up the test set

Before the test set can be controlled through a Remote Desktop Connection, it must be set up to allow connection from a remote computer.

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>To perform this operation successfully, you must have Administrator level access to the test set. The default Administrator password is: Keysight4u!</td>
</tr>
<tr>
<td>2</td>
<td>On the test set, open the Windows Control Panel. Using the Virtual Front Panel within the test set application, press System &gt; Control Panel. Or, from the Windows Desktop, click Start &gt; Control Panel.</td>
</tr>
<tr>
<td>3</td>
<td>Within the Control Panel, select System &gt; System and Security.</td>
</tr>
<tr>
<td>4</td>
<td>Click Remote Settings. A System Properties window appears, with the Remote tab displayed.</td>
</tr>
<tr>
<td>5</td>
<td>Check the box labeled Allow Remote Assistance connections to this computer, if it is not already checked.</td>
</tr>
<tr>
<td>6</td>
<td>To add users, click Select Users &gt; Add. Follow the on-screen instructions.</td>
</tr>
</tbody>
</table>

Setting up the remote computer

The procedure depends on whether the Remote Computer to be set up is running Windows XP, Windows 7, or another version of Microsoft Windows.

Remote computer running Windows XP or Windows 7

Windows XP and Windows 7 include the Remote Desktop Connectivity Client software, so no additional setup is required.

Remote computer running another version of Windows

You can use any 32-bit version of Windows (Windows 95, 98, ME, NT4, or 2000) to install and run the Client software for Remote Desktop Connectivity. However, you need to have available a Windows XP or Windows 7 installation CD-ROM, because that contains the Client software.
Windows Operating System
Remote Desktop: Using the Test Set Remotely

The following instructions relate to software provided by Microsoft Corporation. Keysight offers no warranty regarding the operation of such software. The procedure described here may be changed by Microsoft at some future time.

Table 6-3 Installing the Client software

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>When the Welcome Screen appears, click <strong>Perform additional tasks</strong>.</td>
</tr>
<tr>
<td>2</td>
<td>From the <strong>What do you want to do?</strong> screen, click <strong>Set up Remote Desktop Connection</strong>. The Remote Desktop Connection InstallShield Wizard appears.</td>
</tr>
<tr>
<td>3</td>
<td>Click <strong>Next</strong>. Follow the on screen instructions provided by the Wizard.</td>
</tr>
<tr>
<td>4</td>
<td>To access the installed software, click <strong>Start &gt; All Programs &gt; Accessories &gt; Communications &gt; Remote Desktop Connection</strong>.</td>
</tr>
</tbody>
</table>

How to locate the computer name of the test set

To connect a remote computer to the test set, you need to know its Computer Name. The Computer Name can be displayed as follows:

Table 6-4 Locating the name from the Keysight application

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On the test set front panel, press <strong>System &gt; Show &gt; System</strong>. A page listing various parameters appears. The test set's computer name is shown in the list next to the title Computer Name.</td>
</tr>
</tbody>
</table>

Table 6-5 Locating the name from the Windows desktop (with a mouse)

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click <strong>Start &gt; Control Panel</strong>. In the <strong>Control Panel</strong> window, select <strong>System and Security &gt; System</strong>.</td>
</tr>
<tr>
<td>2</td>
<td>The computer name is displayed in the <strong>System</strong> window, under the heading “Computer name, domain, and workgroup settings”. The computer name is listed as <strong>Full computer name</strong>.</td>
</tr>
</tbody>
</table>
### Table 6-6 Locating the name from the Windows desktop (without a mouse)

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Press <strong>Ctrl+Esc</strong> to display the Windows Start menu.</td>
</tr>
<tr>
<td>2</td>
<td>Use the <strong>Up Arrow</strong> or <strong>Down Arrow</strong> keys to select the Control Panel item.</td>
</tr>
<tr>
<td>3</td>
<td>Press <strong>Enter</strong> to open the Control Panel dialog.</td>
</tr>
<tr>
<td>4</td>
<td>Use the <strong>Tab</strong> key to highlight <strong>System and Security</strong>, then press <strong>Enter</strong>. The <strong>System and Security</strong> window is displayed.</td>
</tr>
<tr>
<td>5</td>
<td>Use the <strong>Tab</strong> key to highlight <strong>System</strong>, then press <strong>Enter</strong>. The <strong>System</strong> window is displayed.</td>
</tr>
<tr>
<td>6</td>
<td>The computer name is displayed in the <strong>System</strong> window, under the heading <strong>Computer name, domain, and workgroup settings</strong>. The computer name is listed as <strong>Full computer name</strong>.</td>
</tr>
<tr>
<td>7</td>
<td>To close the Control Panel dialog: Press <strong>Alt</strong> to open the drop-down File menu Press the <strong>Down Arrow</strong> until the Close menu item is selected Press <strong>Enter</strong> to close the Control Panel dialog.</td>
</tr>
</tbody>
</table>
Running a Remote Desktop session

Initializing a Remote Desktop session

To initialize a Remote Desktop Session, you need to know the Computer Name of the test set. This information can be shown on the test set display by following the procedure in the section “How to locate the computer name of the test set” on page 149.

After setting up both the test set and the remote computer for Remote Desktop Connectivity, as described in “Setting up Remote Desktop operation” on page 148, you are ready to start a Remote Desktop session.

Table 6-7

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click Start &gt; All Programs &gt; Accessories &gt; Remote Desktop Connection. A Remote Desktop Connection dialog appears:</td>
</tr>
<tr>
<td>2</td>
<td>Enter the computer name or IP address of the test set.</td>
</tr>
<tr>
<td>3</td>
<td>Click Connect. A login dialog box appears.</td>
</tr>
<tr>
<td>4</td>
<td>Enter the login account name and password. The default account name is Instrument and the default password is measure4u, but these parameters may be changed by instrument users.</td>
</tr>
</tbody>
</table>

Only the current User or an Administrator can remotely log into the test set. To see who the current user of the test set is, press Ctrl-Esc on the test set until you can view the current user name on the Start menu. If no one is currently logged into the test set, any valid instrument user can remotely log in.

The test set display appears on the screen of the remote computer. Because the test set front-panel keys are not available when using the test set remotely, three alternative methods are available to perform the functions of the front-panel keys, as detailed in the following sections:

- “Accessing menus for Remote Desktop operation” on page 155
- “Keycode commands for Remote Desktop operation” on page 156
- “The Virtual Front Panel” on page 161
### Setting Remote Desktop options

**Table 6-8 Setting options**

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On the Remote Desktop Connection window, click <strong>Options</strong>. The window expands vertically to show several configuration tabs. The Options dialog has several tabs. Generally, the default settings are correct.</td>
</tr>
<tr>
<td>2</td>
<td>Under the <strong>General</strong> tab, ensure that the <strong>Computer name, User name and Domain name</strong> are set correctly. You may choose to enter the password and save it for future sessions, by checking the <strong>Save my password</strong> box.</td>
</tr>
</tbody>
</table>
3 Click the **Display** tab.

Under **Remote desktop size**, you may select the size of the window in which the test set display appears. Do not select any size smaller than 1024 x 768 pixels. Selecting a remote desktop size smaller than 1024 x 768 results in the test set display not being fully visible. In such circumstances, scroll bars do not appear, so portions of the display are not accessible. Under **Colors**, you may select any setting that uses 15 bits or more. Selecting a color setting that uses less than 15 bits results in dithering and incorrect color rendition of the remote desktop window.

4 Click the **Local Resources** tab.

Click the **More** button to see a selection of local resources; selecting the **Drives** checkbox enables you to transfer data between the remote desktop and the local PC.

To transfer data, click **Start** on the task bar of the remote computer, then click **My Computer**. Explorer opens on the remote computer and displays the drives of both the remote computer and the local computer. You can now copy and paste between the two disk drives.
Windows Operating System
Remote Desktop: Using the Test Set Remotely

Table 6-8  Setting options

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Click the <strong>Experience</strong> tab. To Optimize the performance of the Remote Desktop session, choose the appropriate connection format from the drop-down list.</td>
</tr>
</tbody>
</table>

![Remote Desktop Connection](image.jpg)
Accessing menus for Remote Desktop operation

Using the mouse, right-click the application display window to access the following remote desktop menus:

- **Exit** – Selecting this item closes the Application software.
- **Utility > Page Setup** – Selecting this item opens a printer setup dialog.
- **Utility > Virtual Front Panel** – Selecting this item opens the Virtual Front Panel window, as described in the Section “The Virtual Front Panel” on page 161.

The menus are also available when using the test set directly, provided that a mouse or other pointing device is attached to it.
Keycode commands for Remote Desktop operation

When using the test set in remote desktop mode, the following combinations of remote keyboard keys can be used to perform the operation of the virtual front-panel keys.

**Figure 6-1 Keycodes**

### Remote Desktop Keycodes

<table>
<thead>
<tr>
<th>Analyzer Setup</th>
<th>Marker</th>
<th>Utility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+F1</td>
<td>Ctrl+Shift+O</td>
<td>Ctrl+Shift+C</td>
</tr>
<tr>
<td>Ctrl+Shift+F2</td>
<td>Ctrl+Shift+V</td>
<td>Ctrl+Alt+B</td>
</tr>
<tr>
<td>Ctrl+Shift+F3</td>
<td>Ctrl+Alt+A</td>
<td>Ctrl+Alt+T</td>
</tr>
<tr>
<td>Ctrl+Shift+F4</td>
<td>Ctrl+Alt+M</td>
<td>Ctrl+Shift+E</td>
</tr>
<tr>
<td>Ctrl+Shift+F5</td>
<td>Ctrl+Alt+M</td>
<td>Ctrl+Alt+E</td>
</tr>
<tr>
<td>Ctrl+Shift+F6</td>
<td>Ctrl+Alt+M</td>
<td>Ctrl+Shift+W</td>
</tr>
<tr>
<td>Ctrl+Shift+F7</td>
<td>Ctrl+Alt+M</td>
<td>Ctrl+Shift+R</td>
</tr>
<tr>
<td>Ctrl+Shift+F8</td>
<td>Ctrl+Alt+M</td>
<td>Ctrl+Alt+S</td>
</tr>
<tr>
<td>Ctrl+Shift+F9</td>
<td>Ctrl+Alt+M</td>
<td>Ctrl+Alt+C</td>
</tr>
</tbody>
</table>

### Functions

- **Ctrl+Shift+F**: Analyzer Setup
- **Ctrl+Shift+O**: Input/Output
- **Ctrl+Shift+C**: Auto Couple
- **Ctrl+Alt+K**: Marker
- **Ctrl+Shift+Y**: System
- **Ctrl+Shift+M**: Mode Printout
- **Ctrl+Shift+R**: Recall
- **Ctrl+Shift+L**: Help
- **Ctrl+Shift+B**: Full Screen
- **Ctrl+Shift+E**: Mode Setup
- **Ctrl+Alt+B**: BW
- **Ctrl+Alt+A**: Trace/Detector
- **Ctrl+Shift+T**: Trigger
- **Ctrl+Shift+W**: Sweep/Control
- **Ctrl+Alt+S**: Marker Function
- **Ctrl+Shift+X**: Source
- **Ctrl+Alt+U**: User Printout
- **Ctrl+Alt+N**: Marker
- **Ctrl+Alt+F**: Save
- **Ctrl+Alt+D**: Source
- **Ctrl+Alt+P**: Quick Save
- **Ctrl+Alt+Q**: Mode Printout
- **Ctrl+Alt+M**: Mode
- **Ctrl+Alt+L**: Measure
- **Ctrl+Alt+Z**: Measure Setup
- **Ctrl+Alt+N**: Restart
- **Ctrl+Alt+S**: Single
- **Ctrl+Alt+C**: Cont
### Table 6-9: Keycode commands

<table>
<thead>
<tr>
<th>To initiate the following virtual key:</th>
<th>Press these keys on the remote computer keyboard:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AMPTD Y Scale</td>
<td>Ctrl·Shift·A</td>
</tr>
<tr>
<td>Auto Couple</td>
<td>Ctrl·Shift·C</td>
</tr>
<tr>
<td>Bk Sp</td>
<td>Backspace</td>
</tr>
<tr>
<td>BW</td>
<td>Ctrl·Alt·B</td>
</tr>
<tr>
<td>Cancel (Esc)</td>
<td>Esc</td>
</tr>
<tr>
<td>Cont</td>
<td>Ctrl·Alt·C</td>
</tr>
<tr>
<td>Ctrl</td>
<td>Ctrl</td>
</tr>
<tr>
<td>Decrease Audio Volume</td>
<td>Volume Control slider</td>
</tr>
<tr>
<td>Del</td>
<td>Delete</td>
</tr>
<tr>
<td>Down Arrow</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Enter</td>
<td>Enter (Return)</td>
</tr>
<tr>
<td>File</td>
<td>Ctrl·F</td>
</tr>
<tr>
<td>FREQ Channel</td>
<td>Ctrl·Shift·F</td>
</tr>
<tr>
<td>Full Screen</td>
<td>Ctrl·Shift·B</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>Increase Audio Volume</td>
<td>Volume Control slider</td>
</tr>
<tr>
<td>Input/Output</td>
<td>Ctrl·Shift·O</td>
</tr>
<tr>
<td>Left Arrow</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Marker</td>
<td>Ctrl·Alt·K</td>
</tr>
<tr>
<td>Marker -&gt;</td>
<td>Ctrl·Alt·N</td>
</tr>
<tr>
<td>Marker Function</td>
<td>Ctrl·Alt·F</td>
</tr>
<tr>
<td>Meas</td>
<td>Ctrl·Alt·M</td>
</tr>
<tr>
<td>Meas Setup</td>
<td>Ctrl·Alt·E</td>
</tr>
<tr>
<td>Menu (Alt)</td>
<td>Alt</td>
</tr>
<tr>
<td>Mode</td>
<td>Ctrl·Shift·M</td>
</tr>
<tr>
<td>Mode Preset</td>
<td>Ctrl·M</td>
</tr>
<tr>
<td>Mode Setup</td>
<td>Ctrl·Shift·E</td>
</tr>
</tbody>
</table>
### Keycode commands

<table>
<thead>
<tr>
<th>To initiate the following virtual key:</th>
<th>Press these keys on the remote computer keyboard:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute</td>
<td>Mute checkbox under the Volume Control</td>
</tr>
<tr>
<td>Next Window</td>
<td>Ctrl·Shift·N</td>
</tr>
<tr>
<td>Peak Search</td>
<td>Ctrl·Alt·P</td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl·P</td>
</tr>
<tr>
<td>Quick Save</td>
<td>Ctrl·Q</td>
</tr>
<tr>
<td>Recall</td>
<td>Ctrl·R</td>
</tr>
<tr>
<td>Restart</td>
<td>Ctrl·Alt·R</td>
</tr>
<tr>
<td>Return</td>
<td>Ctrl·Shift·R</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl·S</td>
</tr>
<tr>
<td>Select</td>
<td>Space Bar</td>
</tr>
<tr>
<td>Single</td>
<td>Ctrl·Alt·S</td>
</tr>
<tr>
<td>Softkey 1</td>
<td>Ctrl·Shift·F1</td>
</tr>
<tr>
<td>Softkey 2</td>
<td>Ctrl·Shift·F2</td>
</tr>
<tr>
<td>Softkey 3</td>
<td>Ctrl·Shift·F3</td>
</tr>
<tr>
<td>Softkey 4</td>
<td>Ctrl·Shift·F4</td>
</tr>
<tr>
<td>Softkey 5</td>
<td>Ctrl·Shift·F5</td>
</tr>
<tr>
<td>Softkey 6</td>
<td>Ctrl·Shift·F6</td>
</tr>
<tr>
<td>Softkey 7</td>
<td>Ctrl·Shift·F7</td>
</tr>
<tr>
<td>Source</td>
<td>Ctrl·Alt·U</td>
</tr>
<tr>
<td>SPAN X Scale</td>
<td>Ctrl·Shift·S</td>
</tr>
<tr>
<td>Split Screen</td>
<td>Ctrl·Shift·L</td>
</tr>
<tr>
<td>Sweep/Control</td>
<td>Ctrl·Shift·W</td>
</tr>
<tr>
<td>System</td>
<td>Ctrl·Shift·Y</td>
</tr>
<tr>
<td>Tab</td>
<td>Tab</td>
</tr>
<tr>
<td>Trace/Detector</td>
<td>Ctrl·Alt·T</td>
</tr>
<tr>
<td>Trigger</td>
<td>Ctrl·Shift·T</td>
</tr>
</tbody>
</table>
### Keycode commands

<table>
<thead>
<tr>
<th>To initiate the following virtual key:</th>
<th>Press these keys on the remote computer keyboard:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up Arrow</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>User Preset</td>
<td>Ctrl·U</td>
</tr>
<tr>
<td>View/Display</td>
<td>Ctrl·Shift·V</td>
</tr>
<tr>
<td>Zoom</td>
<td>Ctrl·Shift·Z</td>
</tr>
<tr>
<td>1</td>
<td>1&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>2</td>
<td>2&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>3</td>
<td>3&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>4</td>
<td>4&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>5</td>
<td>5&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>6</td>
<td>6&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>7</td>
<td>7&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>8</td>
<td>8&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>9</td>
<td>9&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>–</td>
<td>Use the – key to enter a negative value, as appropriate&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>. (Decimal Point)</td>
<td>. (Period)&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
<tr>
<td>0 (Zero)</td>
<td>0 (Zero)&lt;sup&gt;a&lt;/sup&gt;</td>
</tr>
</tbody>
</table>

<sup>a</sup> For remote keyboards that feature a numeric keypad, use either the appropriate numeric keypad key or the main keypad key.

---

**NOTE**

The effect of pressing **Ctrl·Alt·Delete** on the keyboard of the remote computer always applies to the remote computer, and not to the test set. Generally, the effect of pressing this key combination is to display the Windows Task Manager. Therefore, pressing this key combination on the remote computer does not allow you to reboot the test set.
Windows Operating System
Remote Desktop: Using the Test Set Remotely

**Ending a Remote Desktop session**

There are two ways to disconnect the remote computer from the test set to end the session:

<table>
<thead>
<tr>
<th>Table 6-10</th>
<th>Ending the session</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step</strong></td>
<td><strong>Notes</strong></td>
</tr>
<tr>
<td>1</td>
<td>Click the X, then click OK. For full-screen, the X appears at the top center of the window. For non full-screen, the X appears in a red box at the right of the window.</td>
</tr>
<tr>
<td>2</td>
<td>Or, when the remote desktop is full screen, move the cursor to the bottom left of the window. Click <strong>Start &gt; Disconnect.</strong> Click <strong>Disconnect.</strong> You are asked to confirm that you want to disconnect.</td>
</tr>
</tbody>
</table>
The Virtual Front Panel

The Virtual Front Panel is a software equivalent of the front-panel key set, which provides another alternate method for test set control. It may be displayed in a separate window on the test set (or remote desktop) display.

**NOTE**

The Virtual Front Panel is also available when using the test set directly, provided that a mouse or other pointing device is attached to it.

Using the mouse, right-click the application display window, then select **Utility > Virtual Front Panel**. The Virtual Front Panel appears, as shown below:

**Figure 6-2  Virtual front panel keys**

When you click a button in the Virtual Front Panel, it performs the operation of the corresponding test set front-panel key. The buttons at the left of the panel, named **Softkey 1** through **Softkey 7**, perform the operation of the respective softkeys. The **Up** and **Down** keys perform the operation of the knob.
Programmatic Control of the Test Set

For information on how to send commands to the test set, using a VISA connection, see the X-Series Signal Analyzer Programmer’s Guide, which is available online at:
http://www.keysight.com/find/mxa_manuals

The individual TRX instruments within the test set chassis are controlled using separate VISA connections; see “TRX Selection” on page 38.
Capturing/Printing Displays and Windows

You need an external keyboard and mouse to use this feature.

**Table 6-11  Saving the desktop**

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Press Print Screen on the external keyboard. This captures the desktop and saves it on the Windows clipboard.</td>
</tr>
<tr>
<td>2</td>
<td>Open a graphics application, such as Microsoft Paint.</td>
</tr>
<tr>
<td>3</td>
<td>Paste the clipboard contents into the application window. The keyboard shortcut Ctrl + v will paste the contents of the clipboard.</td>
</tr>
<tr>
<td>4</td>
<td>Save the image in a file, and/or print it.</td>
</tr>
</tbody>
</table>

**Table 6-12  Saving the currently active window**

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click on the window you want to capture. This activates the window.</td>
</tr>
<tr>
<td>2</td>
<td>Press Alt + Print Screen on the external keyboard. This captures the window and saves it on the Windows clipboard.</td>
</tr>
<tr>
<td>3</td>
<td>Open a graphics application, such as Microsoft Paint.</td>
</tr>
<tr>
<td>4</td>
<td>Paste the clipboard contents into the application window. The keyboard shortcut Ctrl + v will paste the contents of the clipboard.</td>
</tr>
<tr>
<td>5</td>
<td>Save the image in a file, and/or print it.</td>
</tr>
</tbody>
</table>
Windows Shortcuts and Miscellaneous Tasks

This section provides a list of Windows shortcuts (key combinations) that are useful when you operate the test set without an attached mouse and keyboard. (See also “Navigating Windows Without a Mouse” on page 146.) Although these shortcuts are available in any Windows system, they are not commonly used when a mouse and keyboard are attached.

Windows shortcuts (key combinations)

You can use the following combinations of front panel keys to perform basic Windows tasks when using the test set without an attached mouse and keyboard.

<table>
<thead>
<tr>
<th>To do the following:</th>
<th>Press:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the Windows Start Menu</td>
<td>Ctrl+Esc</td>
</tr>
<tr>
<td>Cycle through all open applications</td>
<td>Alt+Tab</td>
</tr>
<tr>
<td>Select the first menu of a menu bar</td>
<td>Alt</td>
</tr>
<tr>
<td>Move through menu headings</td>
<td>Left Arrow, Right Arrow</td>
</tr>
<tr>
<td>Open (drop down) a menu</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Move through items in an expanded menu</td>
<td>Up Arrow, Down Arrow</td>
</tr>
<tr>
<td>Close the current menu selection</td>
<td>Esc</td>
</tr>
<tr>
<td>Cancel the current menu bar selection</td>
<td>Alt</td>
</tr>
<tr>
<td>Open an application's control menu (usually the left-most menu on the menu bar, starting with File)</td>
<td>Alt-Select</td>
</tr>
<tr>
<td>In a dialog: move between tabs</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>In a dialog: move forward through dialog box items</td>
<td>Tab</td>
</tr>
<tr>
<td>In a dialog: move backward through dialog box items</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>In a dialog: open a list box</td>
<td>Alt-Down Arrow</td>
</tr>
<tr>
<td>In a dialog list box or check box: select or deselect items</td>
<td>Select</td>
</tr>
<tr>
<td>In a dialog list box or check box: select or deselect one item at a time</td>
<td>Shift-Up Arrow, Shift-Down Arrow</td>
</tr>
<tr>
<td>In My Computer, expand a selected folder</td>
<td>Enter</td>
</tr>
<tr>
<td>In My Computer, open a folder one level up from the current folder</td>
<td>Bk Sp</td>
</tr>
</tbody>
</table>
Navigating an Application Menu without a Mouse or Keyboard

This example uses Microsoft Excel, but you can use a similar sequence of operations to select and execute any menu item of any application.

To select and execute the item Sheet > Rename option from the Format menu in the menu bar shown below,

Figure 6-3  Format > Sheet > Rename

perform the following operations:

Table 6-14  Changing the sheet name

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Press \textit{Alt} to select the File menu in the menu bar. The focus must be in the appropriate window.</td>
</tr>
<tr>
<td>2</td>
<td>Use the \textit{Right Arrow} and \textit{Left Arrow} keys to move horizontally to the Format menu.</td>
</tr>
<tr>
<td>3</td>
<td>Press the \textit{Down Arrow} to expand the Format menu.</td>
</tr>
<tr>
<td>4</td>
<td>Use the \textit{Down Arrow} and \textit{Up Arrow} keys to move vertically to the Sheet menu item.</td>
</tr>
<tr>
<td>5</td>
<td>Press the \textit{Right Arrow} key to expand the Sheet sub-menu. The Rename sub-menu item appears already selected. If another item in the same sub-menu is required, use the \textit{Down Arrow} and \textit{Up Arrow} keys to move vertically to that item.</td>
</tr>
<tr>
<td>6</td>
<td>Press \textit{Enter} to execute the selected action.</td>
</tr>
</tbody>
</table>
Windows taskbar auto-hide feature

The Windows taskbar should always be in the auto-hide mode when using the test set application. If the taskbar is not set to auto-hide, the lower part of the test set display is obscured by the taskbar.

If a mouse is attached to the test set, and you move the mouse cursor to the bottom of the display (either deliberately or accidentally), the taskbar automatically appears. Provided that the taskbar is in auto-hide mode, you can make it disappear again by moving the mouse cursor away from the bottom of the screen.

If at any time the Windows taskbar is inadvertently set to the non-auto-hide mode, you can restore the auto-hide behavior by doing the following:

Table 6-15 Restoring taskbar auto-hide mode

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Click Start &gt; Control Panel. If not using a mouse, press Ctrl+Esc.</td>
</tr>
<tr>
<td>2</td>
<td>Click Appearance and Personalization, Taskbar and Start Menu. If you are not using a mouse, use the shortcut key combinations specified in the Section “Windows shortcuts (key combinations)” on page 164 to make these selections.</td>
</tr>
<tr>
<td>3</td>
<td>Click the Taskbar tab. The Taskbar and Start Menu Properties dialog appears.</td>
</tr>
</tbody>
</table>
Windows Operating System
Windows Shortcuts and Miscellaneous Tasks

Table 6-15  Restoring taskbar auto-hide mode

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 Select the Auto-hide the taskbar check box.</td>
<td>If you are not using a mouse, press Tab repeatedly until the auto-hide option is selected, then press Select to toggle the check box state.</td>
</tr>
<tr>
<td>5 Click OK.</td>
<td>This applies the change and closes the dialog box.</td>
</tr>
</tbody>
</table>
Windows startup folder

All Windows systems include a special folder, called the Startup folder. If a program, or a shortcut to a program, is placed in the Startup folder (either by Windows itself, or by a third-party application, or by any user), that program automatically runs every time Windows is restarted.

When your test set is first configured by Keysight, shortcuts to the appropriate application software and supporting programs are placed in the Startup folder. The exact contents of the Startup folder depends on the options you purchased with your test set.

You should never delete items that appear in the Startup folder, or move any item from the Startup folder to another folder. Deleting or moving any item in the Startup folder may cause applications not to start automatically when Windows is restarted, or may cause certain options to be unavailable when using the test set.

If you wish to view the contents of the Startup folder, do one of the following:

- Either click **Start**, **All Programs**, then select **Startup**, or,

- Click **Start**, **My Computer**, then navigate to the folder:
  
  `C:\Documents and Settings\All Users\Start Menu\Programs\Startup`

Additional startup items may also appear in the corresponding startup folder for the user that is currently logged on. For example, the startup folder for the `administrator` user is `C:\Documents and Settings\administrator\Start Menu\Programs\Startup`. 
7 Troubleshooting

The following topics can be found in this section:

“Check the Basics” on page 170
“Problems with Microsoft Windows Operating System” on page 172
“Returning a test set for Service” on page 173

WARNING No operator serviceable parts inside. Refer servicing to qualified personnel. To prevent electrical shock do not remove covers.
Check the Basics

- Is there power at the receptacle?
- Is the test set turned on? Check to see if the blue power light and the green fan LEDs beside the power switch are on and steady. Also, listen for internal fan noise to determine if the test set cooling fans are running.
- If other equipment, cables, and connectors are being used with your test set, make sure they are connected properly and operating correctly.
- If the test set cannot completely load or run the operating system, or the instrument application is not successfully launched, the problem could be a corrupt hard drive. If the test set gets far enough along in the boot process to run the "Keysight Recovery System", perform the “Hard Drive Recovery Process” on page 135. (The bootup process will be visible only if you have connected an external monitor.)
- Is the Measurement Application running? If not, there is a software launch shortcut/icon on the desktop.
- Does the test set application have the focus? (That is, is the blue window banner highlighted?) If not, move focus to the application with Alt-Tab.
- Review the measurement procedures being performed when the problem first appeared. Are all of the settings correct?
- If the test set is not functioning as expected, return the test set to a known state by pressing Mode Preset.

Some test set settings are not affected by a Preset. If you wish to reset the test set settings, press System > Power On > Restore Power On Defaults.

- Is the measurement being performed, and the results that are expected, within the specifications and capabilities of the test set? Refer to the specifications in the data sheet for your test set, which is available on the Keysight website: http://www.keysight.com/find/e6640a
- If the test set is not communicating via the LAN connection, check the LAN cable connection at the front panel.
- To meet specifications, the test set must be aligned. Either the Auto Align (On) feature must be selected (press System > Alignments > Auto Align > Normal), or the test set must be manually aligned.
- Perform an Alignment. Press System > Alignments > Align Now > All.
Troubleshooting
Check the Basics

– If the previously performed alignments did not resolve the problem, press System > Alignments > Restore Align Defaults. Then press System > Alignments > Align Now > All.

NOTE

The test set must be powered on for 45 minutes prior to performing alignments.

– Is the test set displaying an error message? If so, refer to the Instrument Messages Guide.

– Check if the external frequency reference is selected but not available. Verify that it is selected by pressing Input/Output > Freq Ref In. If External is selected, changing the setting to Sense allows the test set to sense the presence of an external reference and use it only if it is available. The frequency of the reference should be set correctly.

– If you are using a Windows program, other than the test set application, you may notice it running slow. Place the test set application in single sweep/measurement.
Problems with Microsoft Windows Operating System

The Microsoft Windows operating system settings have been optimized for the best performance. Modification of these settings may degrade test set performance and measurement speed. Those that can be safely modified are described in "Settings that can be changed" on page 123.

The E6640A EXM Wireless Test Set operates in an open Windows environment, so you can install software on the test set. However, installation of non-approved software may affect test set performance. Keysight does not warrant the performance with non-approved software installed.
Returning a test set for Service

Read the Warranty

The warranty for your test set is in the front of your Specifications Guide. Please read it and become familiar with its terms.

If your test set is covered by a separate maintenance agreement, please be familiar with its terms.

Service Options

Keysight Technologies offers several optional maintenance plans to service your test set after the warranty has expired. Call your Keysight Technologies office for full details.

Calling Keysight Technologies

Keysight Technologies has offices around the world to provide you with complete support for your test set. To obtain servicing information or to order replacement parts, contact the nearest Keysight Technologies office listed in the following table. In any correspondence or telephone conversations, refer to your test set by its product number, full serial number, and software revision.

Press System > Show > System, and the product number, serial number, and software revision information is displayed on your test set screen. A serial number label is also attached to the rear panel of the test set.

Locations for Keysight Technologies

For a listing of service locations, see http://www.keysight.com/find/assist

Contact us: http://www.keysight.com/find/contactus
Packaging the Test Set

Use original packaging or comparable. It is best to pack the unit in the original factory packaging materials if they are available.

**CAUTION**

Test set damage can result from using packaging materials other than those specified. Never use styrene pellets in any shape as packaging materials. They do not adequately cushion the test set or prevent it from shifting in the carton. They cause test set damage by generating static electricity and by lodging in the test set louvers, blocking airflow.

You can repackage the test set with commercially available materials, as follows:

<table>
<thead>
<tr>
<th>Step</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Wrap the test set in antistatic plastic to reduce the possibility of damage caused by electrostatic discharge.</td>
</tr>
<tr>
<td>2</td>
<td>Use a strong shipping container. The carton must be both large enough and strong enough to accommodate the test set. A double-walled, corrugated cardboard carton with 159 kg (350 lb) bursting strength is adequate. Allow at least 3 to 4 inches on all sides of the test set for packing material.</td>
</tr>
<tr>
<td>3</td>
<td>Surround the equipment with three to four inches of packing material and prevent the equipment from moving in the carton. If packing foam is not available, the best alternative is plastic bubble-pak. This material looks like a plastic sheet filled with 1-1/4 inch air bubbles. Use the pink-colored bubble which reduces static electricity. Wrapping the equipment several times in this material should both protect the equipment and prevent it from moving in the carton.</td>
</tr>
<tr>
<td>4</td>
<td>Seal the shipping container securely with strong nylon adhesive tape.</td>
</tr>
<tr>
<td>5</td>
<td>Mark the shipping container “FRAGILE, HANDLE WITH CARE” to assure careful handling.</td>
</tr>
<tr>
<td>6</td>
<td>Retain copies of all shipping papers.</td>
</tr>
</tbody>
</table>